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ABSTRACT

L’epilessia ¢ una malattia cerebrale caratterizzata da una predisposizione duratura a generare delle
crisi epilettiche con inevitabili conseguenze psicosociali. Nel mondo le persone affette da epilessia
sono circa 50 milioni e l'incidenza € molto piu alta nei giovani e nei piu anziani. Tutt’oggi molti
aspetti di questa malattia rimangono poco chiari come ad esempio la morte improvvisa ed
inaspettata in epilessia (fenomeno SUDEP, in inglese Sudden Unexpected Death in Epilepsy) la
quale non ¢ dovuta da cause accidentali o da uno stato di male. Lo scopo della mia tesi ¢ quello di
analizzare, con 1’'uso di EEGLab (un toolbox di MATLAB), un tracciato elettroencefalografico di un
soggetto epilettico. L’ultima parte della mia tesi, invece, ha lo scopo di mostrare come individuare,
mediante un plugin di EEGLab, EPINETLab, la zona di esordio della crisi epilettica. L'epilessia ¢
una malattia del sistema nervoso centrale che provoca una ripetizione transitoria di segni e/o
sintomi dovuta ad una attivita neuronale cerebrale anomala, eccessiva o sincrona. Il sistema nervoso
centrale ¢ composto dal neurone, dall’encefalo e dal midollo spinale. Il neurone ¢ 1’unita funzionale
principale del sistema nervoso e si occupa dell’elaborazione e della trasmissione delle informazioni
nel cervello. La trasmissione del segnale avviene a causa di uno stimolo depolarizzante che provoca
una modificazione del potenziale di riposo (potenziale d’azione). La trasmissione avviene in punti
di collegamento chiamati sinapsi. Le sinapsi possono essere eccitatorie o inibitorie. I potenziali piu
significativi nella formazione del segnale elettroencefalografico sono i potenziali postsinaptici
eccitatori e 1 potenziali postsinaptici inibitori. Il segnale elettroencefalografico dunque ¢ la misura
delle correnti che si sviluppano durante le eccitazioni sinaptiche di molti neuroni piramidali nella
corteccia cerebrale. L’attivita elettrica cerebrale ¢ sempre presente ed ¢ misurata mediante
I’elettroencefalogramma (EEG). L’EEG ¢ un test che rileva l'attivita elettrica nel cervello attraverso
degli elettrodi disposti in modo standardizzato. Il segnale EEG ¢ costituito da bande ben separate e
riconoscibili tra loro, chiamate ritmi. I cinque ritmi principali sono Delta, Theta, Alpha, Beta e
Gamma. L’EEG svolge un ruolo centrale nella diagnosi e nella gestione dei pazienti con disturbi
convulsivi e funzionali nel cervello. L’epilessia per essere riconosciuta come tale deve soddisfare
alcune condizioni. Infatti la presenza di una singola crisi non implica la diagnosi di epilessia. Un
soggetto ¢ affetto da epilessia quando presenta due crisi non provocate (o riflesse) ad una distanza
maggior di 24 ore oppure se presenta una crisi non provocata (o riflessa) ed una probabilita di
ulteriori crisi simile al rischio generale di recidiva (almeno il 60%) dopo due crisi non provocate,
che si verificano nei successivi 10 anni. Per studiare e valutare al meglio un individuo che presenta
delle convulsioni ¢ stata progettata dall’ILAE nel 2017 una classificazione multilivello (tipo di crisi,
tipo di epilessia, sindromi di epilessia). Lo strumento fondamentale per la diagnosi, la prognosi e il
management dell’epilessia, dopo aver fatto I’anamnesi, ¢ I’EEG. I principali tipi di registrazioni che
vengono attuati sono: EEG di routine, EEG Dinamico o EEG delle 24 ore, EEG con
Videoregistrazione ¢ Monitoraggio Video-EEG a lungo termine. II Monitoraggio video-EEG a
lungo termine costituisce I’esame gold standard, ovvero I’esame piu accurato che permette di
confermare dubbi diagnostici permettendo di acquisire il dato clinico insieme a quello
neurofisiologico. In questa trattazione ¢ stato analizzato un tracciato EEG di un paziente di 55 anni
affetto da epilessia ad esordio focale con consapevolezza alterata. Durante 1’analisi presa in
considerazione il paziente ha avuto una crisi epilettica durata un minuto e dieci secondi. L’analisi
con EEGLab, dopo aver ripulito il segnale dalle sorgenti artefattive maggiormente presenti, nel
nostro caso quelle dovute ai movimenti oculari e a quelli muscolari, ¢ stata quella di estrapolare 1
quattro ritmi cerebrali principali (Delta, Theta, Alpha, Beta e Gamma) con il loro rispettivo



elettrodo dominante. Nel nostro studio ¢ emerso che gli elettrodi dominanti nei ritmi Delta, Theta,
Alpha, Beta e Gamma sono rispettivamente F4, F4, F4, T6, FZ. L’analisi mediante EPINETLab,
invece, ¢ stata quella di individuare le oscillazioni ad alta frequenza (HFO, in inglese High
frequency oscillations), che sono dei biomarcatori molto efficaci in caso di epilessia, per poi
localizzare la zona d’esordio della crisi epilettica. In conclusione ¢ emerso dall’individuazione degli
elettrodi dominanti nei vari ritmi cerebrali che il paziente preso in analisi, nell’arco della
registrazione elettroencefalografica, probabilmente sia stato in una condizione di ansia ed ¢ emerso,
dall’analisi con EPINETLab, che la zona d’esordio della crisi epilettica, dunque quella
presumibilmente candidata all'asportazione chirurgica in base all'analisi fatta in questo studio, ¢
quella occipitale.
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INTRODUZIONE

“In quell’istante il viso, e specialmente lo sguardo, si stravolge addirittura. Convulsioni e spasmi
corrono per tutto il corpo e per ogni tratto del viso. Un grido spaventoso, indescrivibile, che non
somiglia a nessun altro, erompe dal petto: in quel grido sembra scomparire ad un tratto tutto cio che
che la persona ha di umano, e per I'osservatore ¢ impossibile, anzi difficilissimo, concepire e
ammettere che sia 1’epilettico stesso a mandare quel grido. Pare piuttosto che gridi qualcun altro
dentro di lui.” E cosi che Dostoevskij, affetto da epilessia, ha descritto nel libro “L’idiota”, il
momento in cui sopraggiunge la crisi epilettica. L’epilessia, dal verbo greco &miappdvewv
(epilambano) che significa “essere colti di sorpresa”, ¢ una malattia cerebrale caratterizzata da una
predisposizione duratura a generare delle crisi epilettiche con inevitabili conseguenze psicosociali.
Oltre a queste conseguenze, che non sono da sottovalutare, I’epilessia puo essere anche mortale. La
morte improvvisa ed inaspettata in epilessia (fenomeno SUDEP) ¢ un grande punto di domanda al
quale si sta ancora cercando di rispondere poiché essa non ¢ dovuta da cause accidentali o da uno
stato di male, neanche un esame autoptico e tossicologico non ne spiega la causa. Nel mondo le
persone affette da epilessia sono circa 50 milioni e I'incidenza ¢ molto piu alta nei giovani e nei pit
anziani. Le possibili terapie per i1 pazienti epilettici sono: dei medicinali chiamati farmaci
antiepilettici (DAE) che devono essere presi a vita a meno che le convulsioni non iniziano a
scomparire, in tal caso dopo due o tre anni, sotto consiglio del medico, il paziente puo interrompere
I’assunzione; un intervento chirurgico per rimuovere una piccola parte del cervello che causa le
convulsioni; I’inserimento di un piccolo dispositivo elettrico all'interno del corpo che puo aiutare a
controllare le convulsioni (stimolazione del nervo vago o stimolazione cerebrale profonda); una
dieta speciale (dieta chetogenica) che puo aiutare a controllare le convulsioni. Per la diagnosi
dell’epilessia lo strumento cardine ¢ 1’elettroencefalogramma (EEG). L’EEG ¢ un esame che rileva
I’attivita elettrica del cervello mediante degli elettrodi applicati sullo scalpo. Analizzare un segnale
EEG puo essere molto importante per fini diagnostici, infatti, attraverso lo studio delle onde
cerebrali si possono evidenziare condizioni come sonno, coma, morte cerebrale, ansia, depressione,
epilessia, disturbo compulsivo ossessivo, etc. Con queste informazioni il medico riesce a scegliere
al meglio la terapia per il paziente preso in esame. Lo scopo della mia tesi, dopo aver trattato il
sistema nervoso centrale, I’elettroencefalogramma e ’epilessia, ¢ quello di analizzare, con ’uso di
EEGLab (un toolbox di MATLAB), un tracciato elettroencefalografico di un paziente epilettico. 1l
tracciato EEG preso in considerazione appartiene ad un uomo di 55 anni affetto da epilessia ad
esordio focale con consapevolezza alterata. Durante il periodo di analisi che ho studiato il paziente
ha avuto una crisi epilettica. L’analisi attuata comprendera 1’estrazione dei vari ritmi cerebrali e
I’individuazione, su quest’ultimi, delle componenti maggiormente significative e dell’elettrodo
dominante. L’ultima parte della mia tesi, invece, ha lo scopo di mostrare come individuare,
mediante un plugin di EEGLAB, EPINETLab, la zona di esordio della crisi epilettica.



Capitolo 1 - IL SISTEMA NERVOSO CENTRALE

I1 sistema nervoso centrale (o nevrasse) € composto dal cervello e dal midollo spinale; si occupa del
controllo, dell’elaborazione, della trasmissione degli stimoli e delle conseguenti risposte. Prima di
parlare delle sue principali strutture e funzioni € necessario capire come le cellule cerebrali
funzionano individualmente e come lavorano insieme.

1.1 - Il neurone

Il neurone ¢ I'unita funzionale principale del sistema nervoso. Sono i neuroni che, percependo i
cambiamenti nell’ambiente e comunicandoli ad altri neuroni, sono capaci di comandare le risposte
del nostro corpo. Dunque si occupano dell’elaborazione delle informazioni nel cervello. [1]

1.1.2- Struttura del neurone

Inizialmente si credeva che il neurone fosse formato da un unico corpo. Ora sappiamo che non ¢
cosi, la nota struttura classica del neurone infatti fu una scoperta dell’istologo italiano Camillo
Golgi. Nel 1873, Golgi scopri che, immergendo il tessuto cerebrale in una soluzione di cromato
d’argento (macchina di Golgi), una piccola percentuale del neurone diventava di colore scuro.
Grazie a ci0 si ¢ visto che il corpo cellulare neuronale ¢ in realta solo una piccola frazione della
struttura totale del neurone. La colorazione di Golgi mostra che i neuroni sono formati da 2 parti:
una regione centrale contenete il nucleo cellulare e dei numerosi tubi sottili che si irradiano lontano
dalla regione centrale. La regione contenente il nucleo cellulare ¢ chiamata soma (plurale: somata) o
perikaryon (plurale: perikarya) mentre i tubi sottili che si irradiano dal soma sono chiamati neuriti e
sono di due tipi: assoni e dendriti (Figura 1).

Dendridi Corpo cellulare Assone Terminazioni sinaptiche

Figura 1- Struttura del neurone.



Di seguito sono descritte le parti principali del neurone:

* Soma. Il corpo cellulare o soma ¢ la parte centrale del neurone ed ¢ di forma approssimativamente
sferica con un diametro di circa 20 um. Si occupa dell’elaborazione e dell’informazione; come in
ambito informatico fa 1’unita centrale di elaborazione (in inglese central processing unit, CPU). E
costituita da una parte in cui si trova il nucleo (pirenoforo) e da una parte, ovvero il citoplasma, in
cui sono situati tutti gli altri organuli deputati alle principali funzioni cellulari (apparato di
Golgi, neurofilamenti, neurotuboli, granuli di pigmento, sostanza tigroide, mitocondri,
nucleo, reticolo endoplasmatico liscio e rugoso). Tutto cio € racchiuso all’interno della membrana
cellulare (in questo caso neuronale). La membrana neuronale, spessa 5 nm, evita ad alcune
sostanze di entrare all’interno del citoplasma. La membrana ¢ composta da numerose proteine:
alcune pompano sostanze dall'interno verso 1’esterno, altre invece formano dei pori attraverso i
quali regolano quali sostanze possono avere accesso all'interno del neurone. [1]

* Dendrite. I dendriti ( dal greco “albero”) si estendono dal soma come i rami di un albero. I vari
dendriti di un neurone formano collettivamente un albero dendritico mentre ogni singolo ramo
dell'albero ¢ chiamato ramo dendritico. Ogni ramo dendritico ¢ rivestito da piccole protuberanze
chiamate "spine" che si occupano di aumentare e migliorare la superficie ricettiva e di ricevere
cosi gli impulsi eccitatori provenienti da altri neuroni. La vastita delle forme e delle dimensioni
degli alberi dendritici ¢ utilizzata per classificare diversi gruppi di neuroni. I dendriti sono le
antenne del neurone infatti si occupano dell'integrazione temporale, dell'amplificazione e
dell’attenuazione del segnale e del rilevamento di ingressi in entrata [2]. Come vedremo nel
paragrafo successivo i dendriti sono coperti da migliaia di punti di collegamento che permettono
al segnale nervoso di propagarsi, il punto in cui avviene la propagazione viene chiamato sinapsi.
[1]

» Assone. L’assone ¢ una struttura cilindrica, tipica dei neuroni, che si occupa del trasferimento di
informazioni lungo il sistema nervoso. La sua lunghezza varia dal tipo di neurone, infatti, alcuni
sono lunghi pochi mm altri invece, come quelli che vanno dal cervello al midollo spinale, circa un
metro. Il diametro (nell’uvomo) varia da 1 um fino a circa 25 um ed ¢ la parte che influenza la
trasmissione del segnale: piu ¢ sottile e piu I’impulso si muove velocemente. Generalmente ce n’¢
uno solo per cellula. La parte che precede 1’assone corrisponde alla parte terminale del soma e
viene chiamata poggio assone. Successivamente 1’assone ¢ composto da una parte iniziale (cono
d’emergenza), una parte centrale (I’assone proprio) e una parte terminale (assone terminale o
bottone sinaptico). Quest’ultimo ¢ la parte in cui I’assone trasmette I’informazione ad altri neuroni
o cellule. I punto dove avviene questo contatto, come citato precedentemente per il dendrite, si
chiama sinapsi. [1]

Dunque possiamo concludere che i1 dendriti sono la porta di ingresso del segnale (input) perché
portano le informazioni al soma, mentre gli assoni sono la porta di uscita (output) perché portano le
informazioni generate dal soma ai dendriti di un altro neurone.

1.1.2- Trasmissione del segnale
I neuroni trasmettono I’informazione attraverso impulsi nervosi che corrono lungo 1’assone [1].

Un impulso nervoso € un fenomeno elettrico. La trasmissione di questi segnali si verifica a causa
del potenziale di membrana (differenza di potenziale presente in ogni istante tra I’interno e 1’esterno
della membrana) (Vm) [3]. Quando un neurone non trasmette nessun impulso nervoso il potenziale
¢ in uno stato di riposo. Durante lo stato di riposo, I’azione di una proteina chiamata pompa sodio-
potassio riesce a mantenere una differenza di carica attraverso la membrana cellulare del neurone
trasportando (in modo attivo) ioni sodio dall’interno all’esterno della cellula e ioni potassio
dall’esterno verso I’interno. [3]



Questa differenza di carica genera un potenziale elettrico chiamato potenziale di membrana di
riposo e vale circa -65 mV [1]. La modificazione di questo potenziale di riposo, a causa di uno
stimolo depolarizzante, viene chiamato potenziale d’azione. Il potenziale d’azione si instaura se
questo stimolo raggiunge il valore di soia che corrisponde a circa -55 mV. Un potenziale d’azione,
chiamato anche impulso nervoso, ¢ una carica elettrica che viaggia lungo la membrana di un
neurone. Il potenziale d’azione puo essere spiegato attraverso un aumento transitorio del rapporto
tra le conduttanze del sodio (Nat+) e del potassio (K+) (figura 2); la conduttanza rappresenta la
capacita di far passare cariche elettriche (ioni) in presenza di una forza motrice elettrochimica.
Quando si raggiunge il valore di soglia la conduttanza del sodio (gNa) anticipa quella del potassio
(gK) 1niziando a crescere. Cio provoca un’apertura dei canali di Na in cui il sodio puo passare piu
facilmente. Il Na ¢ positivo, quindi entra carica positiva, e il potenziale di membrana inizia a
crescere assieme alla gK. La crescita ¢ inizialmente lenta, poi, quando si raggiungono 1 -30 mV, -20
mV questa crescita ¢ piuttosto elevata. Si verifica un fenomeno a cascata; piu Na entra piu canali di
Na si aprono aumentando cosi la carica positiva e facendo tendere il potenziale di membrana al
valore di Nerst. Questo perd non avviene perché si iniziano ad aprire i canali del potassio e cosi
inizia a crescere anche gK. La gK, infatti, parte con un certo ritardo rispetto gNa; ovvero parte per
potenziali maggiori. L’apertura dei canali del K con la conseguente fuoriuscita di K provoca una
grande crescita della gK. Esce cosi tanto K da compensare il potenziale dovuto dal Na. I canali del
Na si chiudono e, fuoriuscendo il potassio, diminuisce la carica positiva dentro la cellula fino ad
arrivare ad un valore di saturazione (esce cosi tanta carica positiva che la membrana si
iperpolarizza) e poi ritorna indietro.
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Figura 2 - Confronto della voltaggio-dipendenza gK e gNa

Nel potenziale d’azione possiamo riconoscere 4 zone (figura 3):

* Depolarizazione: Un cambiamento verso valori meno negativi, la membrana diventa meno
polarizzata.

* Overshoot: Picco del potenziale

* Ripolarizzazione: Il potenziale di membrana ritorna al valore di riposo dopo una
depolarizzazione.

* Iperpolarizazione: il potenziale ¢ piu negativo rispetto alla condizione di riposo e tende al valore
di Nerst del potassio (-94 mV).

Durante la fase di depolarizzazione e ripolarizzazione nessun ulteriore potenziale d’azione puo
essere generato, indipendentemente dallo stimolo applicato; questo periodo viene chiamato periodo
refrattario assoluto (PRA). Il PRA ¢ molto importante perché assicura che i potenziali d’azione si
trasmettano in una sola direzione lungo un assone. Successivamente ad esso, durante
I’iperpolarizzazione, viene a instaurarsi il periodo refrattario relativo (PRR). In quest’ultimo
periodo si pud generare un secondo potenziale d’azione solo applicando stimoli con intensita
superiore a quella che ha generato il potenziale precedente.
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Figura 3 - Potenziale d’azione del neurone.

Una volta che il potenziale d’azione ha raggiunto la parte terminale dell’assone, I’informazione in
esso contenuta deve essere trasferita ad un altro neurone. Questo trasferimento avviene in siti
specializzati che, nel 1897 il fisiologo inglese Charles Sherrington, chiamo sinapsi. Questo processo
viene detto trasmissione sinaptica [1]. La cellula che invia I’impulso nervoso si chiama cellula
presinaptica mentre quella che lo riceve si chiama cellula postsinaptica [3]. Esitono due tipi di
sinapsi: le sinapsi elettriche e quelle chimiche. In questa trattazione, poiché la maggior parte della
trasmissione sinaptica nel sistema nervoso umano maturo ¢ chimica, esamineremo la sinapsi
chimica (Figura 4) [1]. Nella sinapsi chimica, le membrane presinaptiche e postsinaptiche sono
separate da una fessura sinaptica larga 20-50 nm che funge da collante fra le due. Il lato
presinaptico, generalmente il termine assonale, contiene dozzine di piccoli vasi sferici chiamati
vescicole sinaptiche. Queste vescicole immagazzinano il neurotrasmettitore, sostanza chimica
utilizzata per comunicare con il neurone postsinaptico [1]. Il potenziale d’azione, raggiungendo il
terminale assonico della cellula presinaptica, provoca ’apertura dei canali del calcio. Il calcio da il
via al processo di esocitosi del neurotrasmettitore (che ¢ contenuto nelle vescicole sinaptiche) nello
spazio ristretto tra le membrane presinaptiche e postsinaptiche. Quest'area ¢ chiamata schisi
sinaptica. Le molecole del neurotrasmettitore viaggiano attraverso la fessura sinaptica e si legano
ai recettori, che sono proteine incorporate nella membrana della cellula postsinaptica [3]. Le sinapsi
possono essere eccitatore o inibitorie: le sinapsi eccitatorie sono quelle in cui I’azione del
neurotrasmettitore induce nella membrana postsinaptica una depolarizzazione (in inglese Excitatory
postsynaptic potential, EPSP) che tende a portare la membrana verso la soglia di generazione di un
potenziale d’azione. La sinapsi inibitoria invece induce alla membrana del neurone postsinaptico
una iperpolarizzazione (in inglese Inhibitory postsynaptic potential, IPSP) che tende infatti a portare
il potenziale di membrana lontano dalla soglia di generazione di un potenziale d’azione. EPSP e
IPSP vengono globalmente indicati come potenziali sinaptici [1]. EPSP e IPSP avranno un ruolo
molto importante nella formazione del segnale elettroencefalografico (EEG) e lo vedremo nei

prossimi capitoli.
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Figura 4 - sinapsi chimica

1.2 - Encefalo

L’encefalo, racchiuso all’interno della scatola cranica, ¢ il centro di controllo dell’intero organismo.

[4] [1]. E la sede madre dell’intelligenza, del pensiero, del ricordo, del comportamento, e dello stato

d’animo. L’encefalo, rielaborando tutti gli stimoli che lo colpiscono, ¢ capace di coordinare

movimento, tatto, olfatto, gusto, udito e vista. L’encefalo ¢ diviso macroscopicamente in tre parti

che possiamo ben distinguere nella figura 5 : cervello, cervelletto e tronco encefalico. [4]

* Il cervello, costituito dal diencefalo e telencefalo, rappresenta la parte piu grande dell’encefalo. 1l
diencefalo, formato principalmente da talamo e ipotalamo, si trova tra il tronco encefalico ed il
telencefalo. Il talamo ¢ un grande centro di trasmissione ed elaborazione delle informazioni
sensitive. La maggior parte degli impulsi sensoriali fanno sinapsi a livello del talamo (ad
eccezione dell’olfatto). L’ipotalamo, invece, ¢ la principale struttura di collegamento tra il sistema
nervoso € quello endocrino, infatti, ¢ il centro di controllo delle emozioni, delle funzioni
autonome e della produzione di ormoni. All’ipotalamo ¢ connessa 1’ipofisi, ghiandola endocrina
che produce ormoni in grado di stimolare e controllare 1’attivita delle altre ghiandole endocrine
dell'organismo. 11 telencefalo ¢ la porzione piti voluminosa e pill esterna del cervello. E suddiviso
dalla scissura interemisferica in due emisferi cerebrali. In generale, I'emisfero cerebrale destro
riceve sensazioni e controlla 1 movimenti della parte sinistra del corpo. Allo stesso modo,
l'emisfero cerebrale sinistro si occupa di sensazioni e movimenti sul lato destro del corpo [1]. Il
telencefalo inoltre € suddiviso in tre strati: la_corteccia cerebrale, la sostanza bianca e i nuclei
della base. La parte piu esterna del telencefalo ¢ la corteccia cerebrale. La corteccia cerebrale ¢
irregolare; ¢ ripiegata in creste che prendono il nome di giri (o circonvoluzioni) ed in cavita
chiamate solchi o fessure. I solchi piu profondi e marcati sono detti scissure e ci permettono di
suddividere la superficie della corteccia in regioni chiamate lobi (mostrate in figura 6). I lobi
prendono il nome dalle ossa del cranio che giacciono su di essi. Infatti abbiamo: lobo frontale,
lobo parietale, lobo temporale e lobo occipitale. Nel lobo frontale si trovano le principali aeree di
controllo motorio, nel lobo occipitale le aree visive, nel lobo parietale le aree sensoriali somatiche
e nel lobo temporale le aree uditive [1]. Inoltre la corteccia ¢ suddivisa in sei diversi strati
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sovrapposti (dal piu esterno al piu interno) che prendono il nome dalle varie cellule che sono
maggiormente presenti in tale strato. [5]

Strato I. E chiamato anche strato molecolare o plessiforme poiché & costituito da una sostanza
grigia corticale in cui le ramificazioni terminali di numerosi dendriti cellulari e gli sfioccamenti
di un gran numero di assoni formano una specie di feltro o “plesso”.

Strato II. E chiamato anche strato granulare esterno poiché ¢ formato da numerose cellule stipate,
piccolissime, rotonde, poligonali o triangolari e simili a dei granuli.

Strato III. E chiamato anche strato delle cellule medie e grandi piramidali esterne poiché ¢
composto in prevalenza da grossi elementi di forma piramidale.

Strato IV. E chiamato anche strato granulare interno poiché & rappresentato da piccole cellule,
molto addensate, sia del tipo piramidale che non piramidale.

Strato V. E chiamato anche strato delle grandi cellule piramidali interne poiché sono presenti
principalmente grandi neuroni piramidali da cui partono le vie motorie.

Strato VI. E chiamato anche strato delle cellule fusiformi o polimorfe poiché ¢ formato da cellule
relativamente addensate di aspetto fusiforme.

Le cellule dello strato III, come vedremo nel paragrafo 2.2, saranno quelle che maggiormente
contribuiscono, grazie alla loro disposizione, a determinare il segnale EEG.

1l cervelletto si trova dietro il cervello (deriva dal latino "piccolo cervello"). E principalmente il
centro di controllo del movimento ed ha varie connessioni con il cervello e con il midollo spinale.
Si occupa della postura, della coordinazione muscolare e dell'elaborazione delle informazioni
sensoriali. Contrariamente agli emisferi cerebrali, la parte sinistra del cervelletto si occupa dei
movimenti della parte sinistra del corpo mentre la parte destra del cervelletto riguarda i
movimenti della parte destra.[1]

Il tronco encefalico ¢ composto dal bulbo, dal ponte ¢ dal mesencefalo [4][1]. Rappresenta un
nesso complesso di fibre e cellule che serve a trasmettere informazioni dal cervello al midollo
spinale e al cervelletto, e viceversa. Il tronco encefalico ¢ anche il sito in cui sono regolate le
funzioni vitali, come la respirazione, la coscienza e il controllo della temperatura corporea. Infatti,
anche se il tronco encefalico ¢ considerato la parte piu primitiva del nostro cervello, rappresenta
anche la piu importante per la vita. Possiamo sopravvivere a danni al cervello o al cervelletto, ma
1 danni al tronco encefalico sono generalmente fatali. [1]

Cervello

— ""‘ “_—-.._,L
Tronco “ N\ W% = Cervelletto

encefalico '\

Figura 5 - Struttura dell’encefalo



Figura 6 - Lobi della corteccia cerebrale

1.3 - Midollo spinale

Il midollo spinale ¢ accolto nella colonna vertebrale ossea ed ¢ collegato al tronco encefalico. Ha
inizio in corrispondenza della prima vertebra cervicale e si conclude sulla seconda vertebra
lombare. Il midollo pud essere suddiviso in 31 segmenti (8 cervicali, 12 toracici, 5 lombari, 5
sacrali, 1 coccigeo) ed ¢ il principale canale di informazione dalla periferia al cervello. Infatti, il
midollo spinale, riesce a comunicare con il corpo attraverso i nervi spinali (che fanno parte del
sistema nervoso periferico). Sono presenti 31 paia di nervi spinali, a ogni vertebra ne corrisponde
uno, piu un primo nervo che si origina tra I’osso occipitale e 1’atlante. Ciascun nervo spinale si
attacca al midollo spinale per mezzo di due rami, la radice dorsale e la radice ventrale [1]. Dunque i
neuroni nel midollo spinale sono importanti sia per quanto riguarda la trasmissione dei segnali dalla
periferia all’encefalo e sia nella trasmissione di impulsi dall’encefalo agli organi effettori. Una
rappresentazione del midollo spinale la possiamo ben vedere nella figura 7 sottostante.

Segmenti cervicali (1-8)
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Segmenti toracici (1-12)
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Figura 7 - Nervi e suddivisioni del midollo spinale



Capitolo 2 - ELETTROENCEFALOGRAMMA

2.1 - Definizione e origine del tracciato elettroencefalografico

L’elettroencefalogramma ¢ un test che rileva l'attivita elettrica nel cervello attraverso degli elettrodi.
L’inizio dell’epoca elettronica la possiamo far risalire intorno al XVIII secolo quando Luigi
Galvani, un fisiologo italiano, scopri I’“elettricita animale”. Galvani noto, attraverso un esperimento
effettuato sulle delle rane, che quando veniva stimolata un’estremita di un nervo periferico si
riscontrava invariabilmente che all’altra estremita veniva trasmesso un impulso elettrico. Nel 1875
Richard Caton, medico britannico, mosso dalla curiosita di vedere se cio che valeva per il sistema
nervoso periferico valesse anche per il sistema nervoso centrale inizio 1 suoi primi esperimenti.
Caton, collegando degli elettrodi alla corteccia cerebrale di un cane anestetizzato, scopri per la
prima volta che il cervello era in grado di generare elettricita. Cio fu di grande interesse perché il
cane anestetizzato, non ricevendo stimoli sensori, non doveva mostrare variazioni fisiologiche
mentre invece mostrava un potenziale elettrico che fluttuava rapidamente. Dunque, il cervello non
era un semplice automa che rispondeva solo se stimolato ed inoltre il suo stato neutro non era riposo
ma attivitd. La registrazione dell’attivita elettrica di volontari umani pero dovette aspettare lo
sviluppo di un processo alternativo che evitava di mettere a nudo la corteccia cerebrale dell’uomo.
Infatti, poiché 1 potenziali bioelettrici del cervello, misurati direttamente sulla superficie della
corteccia, sono estremamente deboli, lo saranno ancora di pit quando vengono misurati sullo
scalpo, a causa della resistenza elettrica dovuta agli strati intermedi e sopratutto a causa del cranio.
Infatti anche 1 piu sensibili strumenti del XIX secolo non potevano registrare ampiezze dell’ordine
del microvolt. Successivamente, la scoperta dell’amplificatore a valvole nei primi del XX secolo
offri gli enormi gradi di amplificazione necessari per queste registrazioni. Cosi, Hans Berger,
neuropsichiatra tedesco, riusci nel 1924 , grazie all’invenzione di questo amplificatore, a registrare
I’attivita elettrica del cervello umano posizionando strisce metalliche (elettrodi) sullo scalpo del
soggetto. Berger si aspettava di osservare delle fluttuazioni randomiche, cosi come avveniva nei
cervelli di vari animali, ma notd a sua sorpresa che i soggetti umani mostravano oscillazioni
ritmiche. Berger chiamo la registrazione di queste onde cerebrali elettroencefalogramma e cosi
facendo spalanco la porta per lo studio della mente umana.

2.2 - Formazione del segnale elettroencefalografico

I potenziali d’azione che incidono significativamente nella misura dell’elettroencefalogramma sono
quelli che si formano nella corteccia cerebrale poiché ¢ la parte dell’encefalo piu vicino allo scalpo.
Il potenziale d'azione puo attraversare lunghe distanze assonali, raggiungendo cosi il terminale
nervoso, senza perdita di ampiezza. Successivamente il potenziale, stimolando il rilascio sulle
vescicole intracellulari attraverso la fessura sinaptica, provoca la fuoriuscita dei neurotrasmettitori e
la conseguente propagazione del segnale al neurone successivo. La risposta cellulare indotta dai
neurotrasmettitori, a livello della membrana postsinaptica, pud essere eccitatoria o inibitoria. Una
risposta eccitatoria promuove la creazione di un impulso nervoso inducendo un potenziale
postsinaptico eccitatorio (EPSP) nel neurone postsinaptico. Una risposta inibitoria, invece, inibisce
la creazione di un impulso nervoso inducendo un potenziale postsinaptico inibitorio (IPSP) nel
neurone post-sinaptico. Sia ’EPSP che I’IPSP, piuttosto che 1 potenziali d'azione, rappresentano la
fonte piu significativa dei segnali EEG registrati sul cuoio capelluto. Infatti, sebbene i1 potenziali
d'azione abbiano un'ampiezza maggiore, i potenziali sinaptici (che hanno un’ampiezza massima di
20 mV) hanno una durata piu lunga (da decine a centinaia di millisecondi). I potenziali d’azione
durano troppo poco (< 2 us) per contribuire all’elettroencefalogramma registrato sul cuoio capelluto
[6]. L’elettroencefalogramma dunque misura il flusso di corrente extracellulare generato dalla
somma spazio-temporale dei potenziali postsinaptici. Questa somma spazio-temporale ¢ dovuta
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anche dalla particolare disposizione delle cellule piramidali, i neuroni corticali (figura 8). Infatti le
cellule piramidali dello strato III e IV della corteccia sono quelle ad essere maggiormente coinvolte
nella genesi del segnale grazie alla disposizione del loro principale dendrite (detto apicale) che ¢
perpendicolare (radiale) alla superficie della corteccia cerebrale. Affinché sia rilevata una variazione
di potenziale sulla superficie, dunque, ¢ necessario che 1’arrangiamento dendritico sia ordinato. In
caso contrario, se la disposizione delle cellule fosse casuale, come nelle cellule non piramidali, ne
risulterebbe una corrente nulla. Le cellule non piramidali, infatti, possiedono dei dendriti corti (che
st collegano ai neuroni vicini) che si diramano in tutte le direzioni; in questo caso, 1 campi elettrici
generati dalle correnti sinaptiche tendono a restare estremamente confinati nell’intorno della cellula,
non permettendo una somma spazio-temporale e rendendo cosi il segnale non rilevabile in
superficie. Riassumendo, i fattori che influenzano la dimensione, la forma e la durata delle onde
EEG includono: la distanza dell'elettrodo di registrazione dal generatore di corrente, 1'orientamento
anatomico dello strato di cellule piramidali che generano il segnale e la durata e il numero di
potenziali postsinaptici attivati in modo sincrono. [6]

Assone proveniente K Qzﬁe?ggﬁégz.eamm
dal talamo &
’ contralaterale

Figura 8 - L’elettrodo registra la differenza di potenziale delle cellule piramidali della corteggia
generando cosi il segnale EEG.

2.3 - Caratteristiche Segnale elettroencefalografico

L’elettroencelografia ¢ un esame che permette di registrare 1’attivita elettrica del cervello. Possiamo
analizzare ’elettroencefalogramma sia basandoci sull’attivita spontanea del cervello e sia mediante
1 potenziali evocati. L’attivita spontanea ¢ sempre presente nel cervello. Essa puo essere misurata
sullo scalpo o direttamente sulla corteccia cerebrale (in questo caso ¢ chiamata
elettrocorticogramma). Il segnale EEG ha un comportamento complesso, dinamico, non lineare e
non stazionario [70]. Un tipico segnale EEG ha un’ampiezza compresa fra 10 uV e 100 pV ed una
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frequenza compresa fra 1 Hz e 100 Hz. La banda del segnale EEG si estende da circa 1 a 50 Hz

anche se tipicamente la maggiore quantita del contenuto informativo si estende fino a 30 Hz [70]. 1l

segnale ¢ costituito da bande ben separate e riconoscibili tra loro, chiamate ritmi. I cinque ritmi

principali sono Alpha, Beta, delta, Theta e Gamma (figura 9). [8] [70]

* Onde Delta (0.5-3 Hz) Le onde cerebrali Delta sono le piu lente ma le piu alte in ampiezza (forti e
rumorose). Sono onde a bassa frequenza e profondamente penetranti. Sono generate nella
meditazione piu profonda, sonno senza sogni, sonno non-REM, trance e incoscienza [8].

* Onde Theta (3-8 Hz) Le onde cerebrali Theta si verificano piu spesso nel sonno, ma sono anche
dominanti nella meditazione profonda. Le onde Theta sono collegate all'apprendimento, alla
memoria, all’intuizione e alla creativita . In Theta, 1 nostri sensi vengono ritirati dal mondo
esterno e focalizzati su segnali che provengono dall’interno [8]. E quello stato crepuscolare che
normalmente sperimentiamo quando ci svegliamo o ci addormentiamo. In Theta siamo in un
sogno; immagini vivide, intuizione e informazioni al di la della nostra normale consapevolezza
cosciente. E dove teniamo le nostre "cose", le nostre paure, la storia travagliata e gli incubi. Sotto
stress pud manifestarsi come distrazione, mancanza di concentrazione. [8]

* Onde Alpha (8-12 Hz). Le onde cerebrali Alpha sono dominanti durante 1 pensieri e alcuni stati
meditativi. Alpha ¢ lo stato di riposo per il cervello. Le onde Alpha aiutano il coordinamento
mentale generale, la calma, la prontezza, la consapevolezza interiore, l'integrazione mente / corpo
e ’apprendimento. [8]

* Onde Beta (12-38 Hz). Le onde cerebrali Beta dominano il nostro normale stato di coscienza di
veglia quando l'attenzione ¢ diretta verso compiti cognitivi e verso il mondo esterno. La Beta ¢
un'attivita "veloce", presente quando siamo vigili, attenti, ansiosi, impegnati nella risoluzione di
problemi, nel giudizio e nel processo decisionale. [8]

* Onde Gamma (38-42 Hz). Le onde cerebrali Gamma sono le onde cerebrali piu veloci (ad alta
frequenza) e si riferiscono all'elaborazione simultanea di informazioni da diverse aree cerebrali.
Le onde cerebrali Gamma trasmettono informazioni in modo rapido e silenzioso [8]. E la piu
sottile delle frequenze delle onde cerebrali; la mente deve essere silenziosa per accedere alla
Gamma. La Gamma inizialmente era definita come "rumore cerebrale di riserva" fino a quando 1
ricercatori hanno scoperto che era altamente attiva quando si trovavano in stati di amore
universale, altruismo e "virtu superiori". La Gamma ¢ anche al di sopra della frequenza di
attivazione neuronale, quindi il modo in cui viene generato rimane un mistero. Si ipotizza che 1
ritmi Gamma modulino la percezione e la coscienza e che una maggiore presenza di Gamma si
riferisca alla coscienza espansa e all'emergenza spirituale.

Onde Beta v vyt Mol pritipr pygs
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Figura 9 - Onde cerebrali
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2.4 - Potenziali evocati

I potenziali evocati (in inglese envoked potentials, EP) sono quelle componenti del segnale EEG
che si presentano in risposta ad uno stimolo (visivo, tattile, uditivo, elettrico, etc). I potenziali
evocati sono nascosti dall’attivita di fondo dell’EEG, infatti hanno un’ampiezza molto bassa che ¢
compresa fra 1-3 uV [70]. La registrazione dei EP rappresenta un test oggettivo, non invasivo che
ha una grande utilita clinica. Ci permette di: accertare la morte cerebrale, valutare I’integrita
spinale, rivelare una condizione anormale del sistema sensoriale quando l'anamnesi e/o l'esame
neurologico sono equivoci; monitorare 1 cambiamenti nello stato neurologico di un paziente;
rivelare la localizzazione delle lesioni che colpiscono le vie sensoriali o sui disturbi legati al
linguaggio; fornire alcune informazioni sulla fisiopatologia di un processo patologico [9]. |
potenziali evocati vengono registrati, come I’EEG, con elettrodi di superficie posizionati sullo
scalpo. Essi sono costituiti da oscillazioni del potenziale elettrico e hanno una forma d’onda
caratterizzata da una serie di deflessioni positive o negative, definite componenti. La localizzazione
di queste componenti ci identifica I’area corticale che ¢ attiva in seguito ad un particolare stimolo. |
parametri analizzati nello studio dei potenziali evento-correlati sono la latenza, ovvero la distanza
temporale tra il momento di applicazione dello stimolo ed il momento di comparsa della
componente, la topografia ovvero la posizione sulla superficie cranica in cui ¢ registrabile la
massima ampiezza della componente e infine ’ampiezza ovvero 1’entita della deflessione della
componente rispetto al livello basale [70]. L’EEG con potenziali evocati, inoltre, permette di
valutare I’integrita spinale, ed inoltre se si sospetta una morte cerebrale, la presenza di tali
potenziali consente di diagnosticare una possibile reversibilita del coma. [10]

2.5 - Disposizione degli elettrodi

Gli elettrodi, posti sul cuoio capelluto o in una apposita cuffia, permettono di effettuare una misura
integrale dell’attivita elettrica dei neuroni cerebrali. Un elettrodo infatti ¢ capace di trasformare le
correnti ioniche, generate per ’attivita nervosa a livello delle sinapsi e della struttura neurologica
del cervello, in correnti elettriche che andranno verso ’EEG. Dal 1958 ¢ stato definito un sistema
internazionale (SI) che potesse standardizzare le registrazioni, fornendo cosi un’ adeguata copertura
dello scalpo per le varie diagnosi. I due principali SI per la disposizione degli elettrodi sono il SI
10-20 e il ST 10-10.

2.5.1 - Sistema internazionale 10-20

Nel sistema internazionale 10-20 1 numeri '10' e 20" si riferiscono al fatto che le distanze tra gli
elettrodi adiacenti sono il 10% o il 20% della distanza totale anteriore-posteriore o destra-sinistra
del cranio. I punti di riferimento sul cranio sono: i punti preauricolari destro e sinistro (depressioni
alla radice dello zigoma, appena anteriori al trago), il nasion (depressione tra gli occhi, appena
superiore al ponte del naso) e I’inion (il punto piu alto della protuberanza dell'osso occipitale, nella
linea mediana) [11]. Ciascuna posizione dell'elettrodo ¢ caratterizzata mediante una lettera e un
numero (o una seconda lettera). La prima lettera si riferisce alla regione della corteccia sottostante
(F = frontale, C = centrale, T = temporale, P = parietale € O = occipitale), 1 numeri indicano la
corrispondente lateralizzazione (i pari sull'emisfero destro, i dispari sul sinistro) mentre la lettera z
individua la posizione sulla linea mediana. Complessivamente quindi il sistema 10-20 comprende
19 siti (8 sul lato sinistro, 8 sul lato destro e 3 centrali) piu due siti auricolari di riferimento. Sulla
base dei punti di riferimento anatomici sopra descritti otteniamo le seguenti misurazioni [11]: la
prima misura viene fatta nel piano sagittale ovvero nella linea mediana del cranio, quella che dalla
nasion, attraversando il vertice (il punto piu alto della testa), arriva all'inion (figura 10-A). La
seconda misura si trova sul piano coronale, ovvero quello che dal punto preauricolare sinistro,
attraversando il vertice, arriva a quello destro (figura 10-B). La terza misura (figura 10-C), che ne
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comprende due, viene fatta partendo dalla nasion fino ad arrivare all’inion pero passando prima per
la zona temporale destra e poi per quella sinistra. La quarta misura viene eseguita sul piano
parasagittale, da Fpl a Ol (attraverso C3) sul lato sinistro e da Fp2 a O2 (attraverso C4) sul lato
destro. Dunque le 21 posizioni standard degli elettrodi sono: Fp2, F4, F8, C4, P4, T4, T6, O2 a
destra; Fpl, F3, F7, C3, P3, T3, TS5, O1 a sinistra; Fz, Cz, Pz lungo la linea mediana; A2 e A1 come
elettrodi auricolari di riferimento.
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Figura 11 - Disposizione finale degli elettrodi nel sistema internazionale 10-20

2.5.2 - Sistema internazionale 10-10

Il sistema internazionale 10-10 ¢ un'estensione del sistema 10-20, infatti vengono aggiunti altri
elettrodi rispetto ai 19 elettrodi che rappresentano l'insieme standard attualmente utilizzato nelle
varie cliniche. I nuovi elettrodi sono stati etichettati usando una combinazione di lettere e numeri
che ¢ coerente con la terminologia standard: FC (sono gli elettrodi tra le file frontali e centrali), FT
(tra le file frontali e temporali), CP (tra le file centrali e parietali), PO (tra le file parietali e
occipitali). Fanno eccezione gli elettrodi situati tra la fila frontopolare e quella frontale, per 1 quali
viene utilizzato "AF" anziché “FP” (indicando il posizionamento frontale anteriore). Questo per
evitare tre lettere, come FPF, o due lettere identiche come FF. E stato necessario aggiungere altri
elettrodi perché il SI 10-20 non includeva elettrodi nella catena inferiore (a livello del punto
preauricolare). Dunque non prendeva in considerazione l'attivita che poteva generarsi nel lobo
temporale del cervello, escludendo cosi delle ipotetiche malattie come ’epilessia del lobo temporale
ovvero un’epilessia focale caratterizzata da crisi diurne e/o notturne. Pertanto, questo nuovo sistema
consente 1’identificazione di 75 posizioni. Nel sistema 10-10 gli elettrodi T3/T4 sono denominati
T7/T8 e gli elettrodi TS5/T6 sono denominati P7/P8.
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Figura 12 - Disposizione elettrodi nel sistema internazionale 10-10
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2.5.3 - Registrazioni ad alta densita

Le disposizioni standard degli elettrodi forniscono una copertura incompleta e parziale del cervello
ma nella maggior parte dei casi sono un buon compromesso nella routine quotidiana. Gli elettrodi
aggiuntivi, infatti, richiedono tempo e impegno da parte dei tecnici. I sistemi standardizzati 10-20 o
10-10 ci assicurano varie analisi, come la diagnosi di encefalopatia, il monitoraggio del coma, la
ricerca di scariche generalizzate, etc. Tuttavia, la copertura con questi montaggi standard ¢ limitata
e l'attivita epilettogena potrebbe essere trascurata. Infatti, se esiste un alto sospetto di epilessia, ma
non ¢ possibile rilevare scariche epilettiformi con le disposizioni standard, o € necessaria una
localizzazione precisa del focus epilettico (mediante il sistema 10-10 ma completamente
modificato) o sono necessari sistemi di registrazione ad alta densita con ancora piu elettrodi (Figura
13-b). L’elettroencefalogramma ad alta densita (in inglese High Density Electroencephalography,
HD-EEG) ¢ composto da 64-256 elettrodi ed ¢ diventato uno strumento sempre piu usato negli
ultimi 10 anni. Gli sviluppi tecnici, infatti, hanno reso sempre piu facile I'applicazione di un gran
numero di elettrodi, il che € particolarmente utile nel contesto clinico. ’HD-EEG ¢ un sistema di
elettrodi geodetici (elettrodi equamente distribuiti su uno spazio curvo) che forniscono un
campionamento denso e uniforme su tutto il cuoio capelluto, sul collo sulle guance, consentendo
cosi di rilevare l'attivita cerebrale che altrimenti potrebbe essere trascurata. Gli elettrodi possono
essere fissati e misurati uno ad uno direttamente sul cuoio capelluto del paziente (questo metodo
risulta molto ingombrante ed ¢ infatti da escludere nel caso in cui gli elettrodi siano piu di 64) o
applicati utilizzando delle reti o dei cappucci espandibili (figura 13-a). Un maggior numero di
elettrodi, dunque, permette una maggior copertura per piu regioni cerebrali e, logicamente,
consentono una migliore localizzazione e definizione delle fonti epilettogeniche. L'analisi visiva da
sola pero, alcune volte, puo risultare molto difficile. Pertanto, sono stati sviluppati algoritmi di
localizzazione delle fonti, chiamati imaging di sorgenti elettriche ad alta densita (HD-ESI), che ci
permettono di stimare le fonti cerebrali che danno origine a determinate distribuzioni EEG del cuoio
capelluto. L'HD-ESI viene utilizzato principalmente nel contesto della valutazione prechirurgica
con l'obiettivo di identificare al meglio le fonti elettriche dell'attivita epilettogena per la resezione
chirurgica di questa zona. [11]
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Figura 13: a) Elettrodi per la registrazione HD-EEG posti su un cappuccio; b) Disposizione elettrodi
HD-EEG [12]
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2.6 - Analisi di un tracciato elettroencefalografico

L’analisi dell'attivita elettrica del cervello venne facilitata con I’avvento del computer quando si
riusci a convertire il segnale da analogico a digitale “A/D”. Uno degli usi principali del computer ¢
quello di separare, pulire ed estrarre i segnali significativi dagli artefatti (che rendono indecifrabile
ogni singola registrazione) [13]. Ci possono essere infatti varie fonti di artefatti fra cui il rumore di
fondo, le attivita muscolari (battito di ciglia), i movimenti dei cavi elettrici, telefoni presenti nelle
vicinanze, etc. La digitalizzazione consente un’analisi multimodale dell’EEG che fornisce risposte
specifiche a domande del tipo: cosa accade, quando accade, dove accade, quanto accade (Figura
14). [14]

ANALISI ELETTROENCEFALOGRAFICHE

Modalita di analisi| T

Tracciato
ampiezza/tempo

Cosa? Quando?

Mappe
topografiche Dove?
(ampiezza o frequenza)
Spettri
. ?
di potenza Quanto?

Figura 14 - Tipi di analisi elettroencefalografiche [14]

L’analisi in tempo/frequenza ¢ I’analisi principale che si attua sul tracciato EEG e consente,
visualizzando a video il tracciato, di vedere cosa accade e quando accade. Molto importanti sono
anche le mappe topografiche che permettono ad esempio di vedere, attraverso strumenti di analisi
come EEGLab, dove un’eventuale crisi sia maggiormente presente ovvero in che elettrodo sullo
scalpo un tale evento ¢ in maggior presenza. L’analisi spettrale invece consiste nel trasformare il
tracciato dal dominio del tempo a quello delle frequenze. Quest’ultima fornisce sia informazioni sul
contenuto armonico del segnale (ovvero in che range di frequenza troviamo il contenuto maggiore)
e sia sulle eventuali ciclicita esistenti ovvero quante volte accade un dato evento. L’analisi
principale attuata su un tracciato EEG ¢ 1’analisi in tempo frequenza e lo strumento per eccellenza ¢
’analisi di Fourier.

2.6.1 - Trasformata di Fourier

Il principio alla base dell'analisi di Fourier ¢ che qualsiasi forma d'onda periodica, per quanto
complessa, puo essere espressa come la composizione di termini armonici che hanno una data
ampiezza e frequenza multipla di quella fondamentale. Tra le tecniche di analisi spettrale, la
trasformata di Fourier (in inglese Fourier transform, FT) ¢ considerata la migliore trasformazione
tra 1 domini del tempo e della frequenza in quanto ¢ invariante allo spostamento temporale [15]. La
formula ¢ datada (1) :

X(f) =] x(tyeN—j2xft) dt [+o0to—o0] (1)
La trasformata di Fourier, quindi, consente di studiare il segnale nel dominio delle frequenze dove
puo essere scomposto come una somma di sinusoidi. Ci permette cosi di isolare I’informazione di
interesse poiché gli elementi base coinvolti nella componente di origine elettroencefalografica sono
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disgiunti da quelli coinvolti nella componente di disturbo [16]. L’utilizzo della trasformata di
Fourier per l’analisi del’EEG pero fu subito ostacolata dalla non stazionarieta del segnale
elettroencefalografico [16]. Infatti, quando la trasformata di Fourier viene applicata a segmenti
successivi di un segnale EEG si osserva che gli spettri ottenuti variano nel tempo [15]. Un altro
problema dell’applicazione dell’analisi di Fourier ¢ che non fornisce informazioni su come le
componenti di frequenza evolvono nel tempo e quindi sulla loro localizzazione temporale (‘perdita
dell’informazione di posizione’). La trasformata e 1’antitrasformata di Fourier considerano i domini
del tempo e delle frequenze nella loro globalita e separatamente 1’'uno dall’altro. Un interessante
approccio per risolvere tale problema consiste nel cercare di avere una ‘rappresentazione congiunta
tempo-frequenza’ del segnale. L’idea fu di applicare la FT non piu a tutto il segnale EEG, ma ad una
porzione di EEG contenuta in un intervallo (‘finestra’) che trasla nel tempo. L’approccio
tradizionale che introduce la dipendenza temporale nell’analisi di Fourier ¢ la ‘Short Time Fourier
Transform’ (STFT) che consiste nel far scorrere una funzione finestra w(t) (di larghezza Az) lungo

tutto il segnale e calcolare poi la FT in ogni segmento ‘localmente stazionario’; questa procedura
viene iterata fino a coprire 1’intero segnale. La STFT per un dato segnale x(t) ¢ definita nel modo
seguente (2):

STFI(z, f)=] x(t) w(t — 7)-eN—j27 ft) dt [+oo to —o0] Q)
Dove x(t) ¢ il segnale originale. Il modulo quadro della STFT ¢ detto ‘spettrogramma’. Facendo uso
delle DFT e FFT per la stima della STFT, ci si trova di fronte al problema dell’utilizzo di una stessa
finestra per tutte le frequenze, quindi la risoluzione dell’analisi ¢ costante in tutto il piano tempo-
frequenza. [16]

2.6.2 - Trasformata di Wavelet

Un’altro metodo molto efficiente per I’analisi in tempo-frequenza ¢ la trasformata di Wavelet (WT).
WT, infatti, riesce a catturare 1 sottili cambiamenti nel segnale EEG. WT viene utilizzato per la pre-
elaborazione/eliminazione del rumore del segnale e per l'estrazione di elementi. Il WT ¢ stato
sviluppato negli anni '80 come una potente tecnica di elaborazione del segnale per superare le
carenze di altri metodi come la trasformata di Fourier. WT fornisce una rappresentazione fluida a
differenza della rappresentazione in finestra nella trasformata di Fourier a breve termine
(STFT). Quest’ultima infatti mantenendo sempre fissa una data finestra temporale per tutte le
frequenze del segnale analizzato, pud causare una perdita di informazioni a frequenze molto basse o
a frequenze molto alte (infatti il miglioramento della risoluzione nel tempo determina un
peggioramento della risoluzione in frequenza e viceversa per il principio di indeterminazione di
Heisenberg). L'analisi Wavelet di un segnale EEG, invece, permette di ovviare tale problema
utilizzando lunghi intervalli temporali per informazioni piu precise alle basse frequenze e intervalli
temporali piu brevi per informazioni piu precise alle alte frequenze (Figura 15).

(]I

STFT WT

Figura 15 - Risoluzione tempo-frequenza per STFT e WT
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Quindi con la WT si possono catturare dettagli molto minuti, cambiamenti improvvisi e somiglianze
nei segnali EEG. WT agisce come un microscopio matematico, perché ha la capacita di analizzare 1
segnali EEG a scale diverse [17]. Essa scompone il segnale di interesse attraverso un set di funzioni
base chiamate Wavelets. Ognuna di queste funzioni base ¢ una versione traslata e scalata di una
funzione prototipo, la Wavelet madre. Dal confronto fra la STFT e la WT risulta che la WT ¢ un
metodo migliore e piu adatto per 1’analisi del segnale EEG. La ragione di questo successo dipende
dal ridimensionamento e dalle proprieta di spostamento della Wavelet madre.[15]

2.7 - Diagnostica tracciato elettroencefalografico

L’EEG svolge un ruolo centrale nella diagnosi e nella gestione dei pazienti con disturbi convulsivi e
funzionali nel cervello [18]. E, infatti, un modo conveniente per studiare le manifestazioni anormali
di eccitabilita corticale che sono alla base ad esempio dell’epilessia o dell’encefalopatite [19].
Nell’EEG possiamo riconoscere la presenza di anomalie attraverso una maggiore quantita di attivita
lenta (<8 Hz) o attraverso forme d’onda anomale, come onde con una forma appuntita (attivita
epilettiforme) e il verificarsi di schemi speciali [20]. Una maggiore quantita di attivita lenta nello
stato di veglia indica una chiara disfunzione cerebrale [21]. I campi di applicazione del’EEG sono
vari, fra cui:

Diagnosi dell’epilessia.

Diagnosi di un tumore cerebrale (I’attivita elettrica ¢ molto ridotta nella zona tumorale).
Controllo del livello di anestesia raggiunto durante gli interventi chirurgici.

Diagnosi e ricerche sul sonno e sui suoi disturbi.

Valutazione stato di coma.

Determinazione del silenzio cerebrale. Il silenzio celebrare ¢ la perdita irreversibile di ogni
attivita corticale (a meno che il paziente non sia in ipotermia o abbia assunto droghe depressive)
al di sopra della soglia di 2 uV di ampiezza, in determinate condizioni di registrazione.

Morte encefalica.

Diagnosi dell’encefalopatite (demenza, depressione, ecc).

9. Schizofrenia.

A
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Capitolo 3 - EPILESSIA

3.1 - Definizione

L’International League Against Epilepsy (ILAE) definisce nel 2014 1’epilessia come una malattia

cerebrale (e non piu un disturbo come lo era nella precedente definizione del 2005) caratterizzata da

una predisposizione duratura a generare crisi epilettiche e dalle sue conseguenze psicosociali [22].

L’epilessia per essere riconosciuta come tale deve essere caratterizzata dalle seguenti condizioni:

1. Almeno due crisi non provocate (o riflesse) che si verificano a distanza maggiore di 24 ore.

2. Una crisi non provocata (o riflessa) ed una probabilita di ulteriori crisi simile al rischio generale
di recidiva (almeno il 60%) dopo due crisi non provocate, che si verificano nei successivi 10
anni;

3. Diagnosi di una sindrome da epilessia. [22]

Una crisi non provocata ¢ una crisi che si verifica in assenza di fattori precipitanti ovvero eventi che

possono determinare 1’inizio del disturbo in persone che abbiano una predisposizione (eventi

stressanti o traumatici come lutti, abusi, malattie, conflitti familiari, rottura di una relazione
importante, cambio di scuola o di citta).

3.2 - Epidemiologia

Nel mondo le persone affette da epilessia sono circa 50 milioni di persone. Il tasso d’incidenza
risulta essere piu alto nei paesi a reddito medio/basso rispetto ai paesi ad alto reddito. Questo puo
essere spiegato a causa di una maggiore esposizione al pericolo come a rischi perinatali, a tassi piu
elevati di infezioni del SNC e a traumi cranici [23]. L’epilessia ¢ leggermente piu elevata negli
uomini che nelle donne [24]. La differenza potrebbe essere dovuta al genotipo, a una differente
esposizione a fattori di rischio nei due sessi o all’occultamento della patologia nelle donne per
motivi socio-culturali [21]. Inoltre l'incidenza dell'epilessia ¢ piu alta nei giovani e nei piu anziani
[20]; le stime sono di 86 per 100.000 persone all’anno nel primo anno di eta, tendono a diminuire a
circa 23-31 per 100.000 nelle persone di eta compresa tra 30 e 59 anni per poi aumentare fino a 180
per 100.000 nella fascia di eta superiore agli 85 [27]. Negli ultimi decenni pero l'incidenza
dell'epilessia ¢ diminuita nella fascia d'eta piu giovane, probabilmente grazie a migliori cure
perinatali, migliori condizioni igieniche e maggiore controllo delle malattie infettive [26]. Al
contrario, l'incidenza ¢ aumentata negli anziani, probabilmente a causa del miglioramento
dell'aspettativa di vita (con un parallelo aumento delle condizioni epilettogene legate
all'invecchiamento, come ictus, tumori e disturbi neurodegenerativi). [23]

3.3 - Classificazione delle epilessie

La classificazione dell’epilessia ¢ lo strumento clinico chiave che ci permette di valutare al meglio
un individuo che presenta delle convulsioni. La classificazione ci consente di comprendere al
meglio il tipo di crisi che ha il paziente, la probabilita che altri tipi di crisi possano insorgere in
quell’individuo, 1 fattori scatenanti e spesso la loro prognosi. La classificazione delle epilessie si €
evoluta notevolmente dal suo inizio nel 1960. La nuova classificazione ¢ multi-livello (tipo di crisi,
tipo di epilessia, sindromi di epilessia) ed ¢ progettata dall’ILAE nel 2017 [28]. In essa sono
presenti tipi di crisi e di epilessia che precedentemente non erano classificabili ed utilizza una
terminologia piu intuitiva.[29]

3.3.1 - Tipi di crisi

Una crisi € una ripetizione transitoria di segni e/o sintomi dovuta ad una attivita neuronale cerebrale
anomala, eccessiva o sincrona [30]. II primo compito del clinico ¢ determinare che 1’evento in
considerazione abbia le caratteristiche di una crisi epilettica e non di una delle sue tante imitazioni
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[31]. Una volta compreso cosa sia una crisi il passo successivo ¢ identificarla in un tipo di crisi. Le
crisi possono essere focali o generalizzate, oppure se 1’esordio della crisi appare poco chiaro viene
classificata come crisi a esordio sconosciuto (figura 16). [32]
e Crisi Focale. Le crisi focali hanno origine in un solo emisfero cerebrale. Esse sono

successivamente classificate come crisi a consapevolezza integra o a consapevolezza
compromessa. In una crisi a consapevolezza integra 1’individuo ¢ pienamente conscio di sé e
dell’ambiente circostante anche se rimane immobile. Le crisi a consapevolezza compromessa
invece causano una perdita di coscienza producendo perfino esperienze oniriche.
Successivamente le crisi vengono ulteriormente suddivise in base alla presenza di segni motori o
non motori al loro esordio.[32]

Crisi generalizzate. Le crisi generalizzate invece hanno origine in entrambi gli emisferi cerebrali.
Anch’esse sono classificate in crisi motori € non motori (crisi di assenza). Fra le crisi
generalizzate rientrano le “petit mal” e le “grand mal”. Le petit mal (piccolo male) sono le crisi di
assenza, non motorie. Esse sono caratteristiche dell’infanzia. Hanno una breve durata, tipicamente
puo variare frai 5 e i 10 (s), e si verificano ripetutamente nell’arco della giornata separati da brevi
intervalli. In questo stato I’individuo & assente con sguardo fisso e coscienza sospesa. Le gran mal
(grande male) sono le crisi generalizzate motorie tonico-clonico. Esse hanno inizio con
un’improvvisa perdita di coscienza accompagnata tipicamente da un urlo che ¢ dovuto dalla
contrazione del diaframma e dalla fuoriuscita dell’aria attraverso la glottide. L’individuo subito
dopo presenta rigidita muscolare e cianosi. Successivamente compaiono i movimenti clonici dei
quattro arti. Durante questa fase ¢ possibile che 1’individuo si mordi la lingua con successiva
emissione di bava ematica [34]. Le manifestazioni generalizzate delle crisi possono essere
asimmetriche e rendere cosi difficile la distinzione di queste crisi da quelle ad esordio focale. [32]
Crisi ad esordio sconosciuto. Le crisi ad esordio sconosciuto si suddividono in motori, non motori
oppure dal termine ‘“non classificata”. Un tipo di crisi ad esordio sconosciuto puo
successivamente diventare focale o generalizzata. infatti, il termine “esordio sconosciuto” €
considerato come un “segnaposto” poiché non ¢ una caratteristica della crisi, ma una lacuna nella
conoscenza. Una crisi ¢ definibile focale o generalizzata solo se il clinico ha una sicurezza
maggiore dell’80 % altrimenti la crisi dovrebbe rimanere non classificata fino alla disponibilita di
maggiori informazioni. [32]
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Figura 16 - classificazione dei tipi di crisi versione ampliata (ILAE 2017) [32]
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3.3.2 - Tipi di epilessie

Una volta classificato il tipo di crisi, il medico deve identificare il tipo di epilessia del paziente. Per

procedere con la classificazione del tipo di epilessia, il paziente deve aver soddisfatto la diagnosi

redatta nel 2014, infatti, in caso contrario, la classificazione si ferma al tipo di crisi [29]. La
classificazione del tipo di epilessia ha uno spettro pitt ampio rispetto alla classificazione delle crisi.

Infatti, molte epilessie includono diversi tipi di crisi e inoltre ci possono dare informazioni sul

quadro clinico generale, come ad esempio sulla prognosi o comorbidita [29]. L’epilessia puo essere

focale, generalizzata, combinata generalizzata e focale e infine di tipo sconosciuto. Le ultime due

sono state introdotte nel 2017. [29][32]

 Epilessia Focali. L’epilessia focale comprende crisi che possono essere focali o multifocali. Il
paziente dunque puo essere soggetto a vari tipi di crisi focali, tra le quali crisi focali con o senza
compromissione del contatto con I’ambiente circostante, crisi focali motorie € non motorie, € crisi
focali che evolvono in crisi tonico-cloniche bilaterali. [32]

» Epilessia Generalizzata. Il paziente con epilessia generalizzata puo essere soggetto a vari tipi di
crisi tra cui assenze, crisi miocloniche, crisi atoniche, crisi toniche e crisi tonicocloniche.[32]

* Epilessia Combinata Generalizzata e Focale. Questo tipo di epilessia ¢ stata introdotta poiché
alcuni pazienti presentano sia crisi generalizzate sia crisi focali. Un esempio della combinazione
di queste due crisi sono la sindrome di Dravet e la sindrome di LennoxGastaut.[32]

* Epilessia di Tipo Sconosciuto. Quest’ultima invece ¢ stata introdotta per descrivere pazienti che
hanno una epilessia ma il clinico non ¢ in grado di definire se il tipo di epilessia sia focale o
generalizzato per mancanza di informazioni. I motivi possono essere vari: EEG non disponibile o
EEG non informativo (per esempio perché normale).[32]

3.3.3 - Sindromi Epilettiche

Il terzo ed ultimo livello ¢ la diagnosi di Sindrome Epilettica (se non & possibile diagnosticare una
sindrome epilettica ci si ferma al tipo di epilessia). Le sindromi epilettiche sono definite da un
insieme di caratteristiche associate che comprendono tipo di crisi, alterazioni EEG, neuroimaging,
eta (esordio/remissione), fattori scatenanti, periodicita delle crisi, prognosi, comorbidita cognitive/
psichiatriche [32]. Molte di queste sindromi hanno nomi ben noti (sindrome di Dravet e la sindrome
di LennoxGastaut). Sebbene esistano varie sindromi riconosciute, I'lLAE non ha mai classificato
formalmente un elenco di sindromi epilettiche. Probabilmente, poiché nuove sindromi stanno
emergendo costantemente, un’ulteriore classificazione delle sindromi epilettiche potrebbe essere al
centro dei futuri lavori dell’ILAE [29]. L’identificazione di una sindrome epilettica ¢ utile perché ci
fornisce informazioni su quali eziologie sottostanti dovrebbero essere considerate e quali farmaci
anti-epilettici potrebbero essere piu utili. Alcune sindromi epilettiche infatti dimostrano un
peggioramento delle crisi con particolari farmaci anti-epilettici, che puo essere evitato attraverso
un'adeguata diagnosi precoce della sindrome epilettica. [32]

3.4 - Eziologia

L’eziologia ¢ un aspetto molto importante per lo studio dell’epilessia, infatti il medico, fin dal

momento in cui il paziente presenta una prima crisi epilettica, deve cercare di determinarne

I’eziologia ovvero la causa del male [32]. La Task Force ILAE ha definito sei categorie eziologiche

(concentrandosi su quelle con implicazioni gestionali). Queste categorie sono: genetica, strutturale,

metabolica, immunitaria, infettiva, sconosciuta. Queste eziologie non hanno un ordine gerarchico e

possono coesistere in un paziente.[29]

» Eziologia Genetica. L’epilessia a eziologia genetica ¢ il risultato diretto di un difetto genetico
presunto o noto in cui le crisi sono il sintomo principale della malattia. Il difetto genetico puo
manifestarsi a livello cromosomico o molecolare. Genetico non significa per forza ereditario
infatti le mutazioni de novo non sono rare.[32]

* Eziologia Strutturale. Una anomalia strutturale pud comportare un elevato rischio di essere

associata ad epilessia. In una eziologia strutturale sono presenti delle anomalie morfologiche che
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possono risultare visibili con le neuroimmagini, con un esame clinico-anamnestico o con un EEG.
Le eziologie strutturali comprendono cause acquisite (ictus, traumi e infezioni) o genetiche
(malformazioni dello sviluppo corticale). Nel caso di anomalie strutturali di origine genetica
I’epilessia viene comunque definita come strutturale in quanto ¢ causata dalla malformazione. Fra
le principali anomalie strutturali del cervello associate all'epilessia abbiamo: malformazioni dello
sviluppo corticale, malformazioni vascolari, sclerosi dell'ippocampo, anomalie strutturali
ipossico-ischemiche, lesione cerebrale traumatica, tumori epilettogenici e cisti porencefalica. Le
neuroimmagini devono essere esaminate attentamente perché in alcuni casi si deve prendere in
considerazione la chirurgia per l'epilessia (se la terapia medica non risulti efficace).[32]

Eziologia Metabolica. L’Epilessia a eziologia Metabolica ¢ dovuta da uno squilibrio di tipo
metabolico presunto o noto. In questo tipo di epilessia le crisi sono un sintomo principale. Le
cause metaboliche presentano un difetto metabolico ben delineato con manifestazioni o
alterazioni biochimiche sistemiche come porfiria, uremia, amminoacidopatie o crisi piridossino-
dipendenti. I disordini metabolici, per la maggior parte dei casi, hanno una causa genetica mentre
altri invece possono essere acquisiti come il deficit di folati (vitamina del gruppo B).
L'identificazione delle cause metaboliche dell'epilessia risulta essere molto importante poiche puo
portare all’impiego di terapie specifiche e alla potenziale prevenzione del ritardo mentale. [32]
Eziologia Immunitaria. Nell’epilessia a eziologia immunitaria 1 sintomi principali sono le crisi e
un disturbo immunitario. Questa epilessia ¢ da prendere in considerazione quando ¢ presente una
inflammazione del sistema nervoso centrale autoimmune mediata. E molto importante
riconoscerle poiché 'esito puo essere ottimizzato con immunoterapie mirate.[32]

Eziologia Infettiva. L'eziologia infettiva ¢ contagiosa ed ¢ infatti la causa piu comune di epilessia
a livello mondiale. Nell’epilessia a eziologia infettiva le crisi sono un sintomo principale di un
disturbo derivato direttamente da un'infezione nota. Queste epilessie hanno implicazioni
terapeutiche specifiche. [32]

Eziologia Sconosciuta. Questo tipo di eziologia ¢ per tutti quei pazienti per cui la causa
dell’epilessia non ¢ ancora chiara. La possibilita di identificare la causa dipende dalla

disponibilita dei mezzi diagnostici. Esistono molte persone con epilessia a eziologia sconosciuta.
[32]

Eziologia

Genesaliezato
Strutturale

Tipi di epilessia Infettiva

Focale Goneralizzato Sconosciuto
s Metabolica
Sindromi Epilettiche

/4

Co-morbidita

Figura 17 - Struttura della classificazione delle epilessie.
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3.5 - Comorbidita

La comorbidita rappresenta la presenza o ’insorgenza di un disturbo patologico durante il decorso
clinico di una patologia oggetto di studio. Infatti come possiamo notare molte epilessie sono
associate a problemi di apprendimento, psicologici, comportamentali e cognitivi. La comorbidita
dunque, come ’eziologia, ¢ utile da considerare in ogni fase della classificazione per consentirne la
identificazione precoce, la diagnosi e la appropriata gestione. [32]

3.6 - Protocollo diagnostico

La diagnosi ¢ una procedura che permette di identificare il nome e la causa di un male. Nel caso di
una presunta epilessia gli obbiettivi principali per accertarne la diagnosi sono stabilire il tipo di crisi
presentate dal paziente, inquadrare la sindrome e la sua eziologia, escludere eventi che non siano di
natura epilettica e infine definirne la causa. Per fare cid ¢ molto importante interrogare il paziente o
eventuali testimoni per poi procedere con analisi di laboratorio.

3.6.1 - Anamnesi.

L’anamnesi ¢ il principale strumento per la diagnosi, ne consente 1’accuratezza in circa la meta dei
casi. Interrogando il paziente ¢ possibile ricavarne il contesto, i fattori predisponenti, le circostanze
e 1 prodromi dei presunti momenti epilettici e pre-epilettici. Dal contesto il medico apprende in che
posizione si trovava il paziente (supina, seduta o in piedi), che attivita stava svolgendo (era in riposo
oppure durante o dopo un esercizio) e infine la precisa situazione (minzione, defecazione, tosse o
deglutizione). Il medico inoltre riesce a capire dal racconto del paziente i fattori che lo hanno
predisposto all’avvento dell’epilessia come ad esempio possono essere stati dei luoghi caldi ed
affollati, una posizione ortostatica prolungata (stare in posizione eretta), un periodo post-prandiale
(dopo pranzo) o infine il prelievo venoso. Oltre a ci0 il medico apprende anche le circostanze che
hanno dato il via all’epilessia, fra le quali paura, dolore intenso e movimenti del collo. Infine la
presenza o meno dei prodromi ovvero dei segni che hanno preceduto il manifestarsi dell’epilessia
(nausea, vomito, sensazione di freddo, sudorazione, aura, cefalea, dolore alle spalle, dolore toracico,
cardiopalmo, etc) [33]. Un’ulteriore indagine ¢ possibile attuarla anche grazie al testimone che
dovrebbe essere in grado di descrivere i segni e i sintomi intercorrenti e le sequele del momento
epilettico [33]. Attraverso segni e 1 sintomi intercorrenti il medico riesce ad apprendere la
colorazione della cute del paziente durante 1’attacco epilettico (pallore, cianosi), la durata della crisi,
se quest’ultima ¢ stata accompagnata da una perdita di coscienza, 1 vari movimenti, se ¢ avvenuto il
morsus (stringimento della lingua fra 1 denti fino a farsi male) e infine la presenza o assenza del
polso. Il medico inoltre dal racconto di un testimone puo apprendere se sono stati presenti delle
sequele e in caso affermativo la loro durata e quali (nausea, vomito, sudorazione, freddo,
confusione, cefalea, mialgia, traumi, colore della cute) [33]. Con I’indagine anamnestica si deve
riuscire principalmente a escludere eventi che non siano epilettici. Molte volte infatti distinguere
una crisi epilettica da un evento non epilettico (come sincope o crisi psicogena) non ¢ sempre facile.
Anche quest’ultimi presentano elementi caratteristici dell’epilessia come ad esempio scosse
miocloniche, occhi verso I’alto e brevi automatismi. Inoltre con I’indagine amnestica si deve
riuscire anche ad: indicare se si tratta di una prima crisi epilettica o di una ripetizione di crisi,
descrivere eventuali sintomi premonitori, identificare e definire 1 sintomi localizzatori (con
attenzione particolare al disturbo di coscienza), fornire informazioni riguardo la fase di recupero
(sintomi post-critici), identificare eventuali fattori eziologici gia conosciuti e/o scatenanti. Cio che
distingue maggiormente una crisi di tipo epilettico ¢ la cianosi, I’ipersalivazione, il morsus e lo stato
confusionale post-critico.
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3.6.1 - Indagini di laboratorio.

Per avere una diagnosi definitiva, nel caso in cui I’anamnesi non porti ad un risultato sicuro, oppure

nel caso di pazienti con crisi di nuova insorgenza o manifestazioni atipiche, si attuano analisi di

laboratorio.

* EEG. L'EEG aiuta a determinare il tipo di crisi e la sindrome epilettica nei pazienti con epilessia.
Puo anche fornire sostegno sulla scelta del farmaco antiepilettico e sulla previsione della prognosi
[35]. L’epilessia, essendo caratterizzata da periodi di attivita elettrica intensa nel cervello (dovuta
da un aumento di eccitazione e una diminuzione di inibizione) puo essere ben riconosciuta in un
EEG (figura 18). Alcuni quadri EEG, infatti, sono tipici di specifiche sindromi epilettiche e ne
confermano la diagnosi (es. scariche di complessi punta-onda diffusi a 3 Hz nelle assenze tipiche).
Anche le scariche epilettiformi interictali (IEDs) sono onde caratteristiche che ci permettono di
riconoscere, mediante EEG, attacchi epilettici da quelli non epilettici. Le IEDs comprendono le
punte, le ondulazioni pronunciate, i complessi di punta-Wave e 1 poly spikes. Tuttavia, gli attacchi
non sono prevedibili e quindi, a meno che non si stia facendo un EEG durante ’attacco, le IEDs
non verranno registrate. Per risolvere questo problema ¢ importante che i pazienti si sottopongano
a elettroencefalogrammi ripetuti a lungo termine. Altre tecniche per riuscire a catturare le IEDs
sono attuate con la privazione del sonno (la privazione del sonno aumenta le possibilita di trovare
scariche epilettiformi interictali su un EEG nel 30-70% dei casi), l'iperventilazione e lo stimolo
photic. Oppure, soprattutto nel bambino, le IEDs hanno piu probabilita di verificarsi durante il
sonno dunque deve essere garantito anche un EEG durante la notte. La specificita dell’EEG nella
diagnosi dell’epilessia ¢ abbastanza alta, infatti le persone che non sono affette da epilessia ma
che comunque presentano scariche interictali (tipiche dei soggetti epilettici) sono al massimo il
3%. I maggiori problemi sono dovuti dal fatto che alcuni pazienti con epilessia possono avere
degli EEG normali oppure che un EEG potrebbe non denotare con precisione la sindrome di
epilessia portando cosi a diagnosi errate. Infatti i picchi interictali o le anomalie epilettiformi
possono essere dovute anche dalle assunzioni di farmaci come cefepime, bupropione, litio,
tramadolo e clozapina. Dunque la presenza di una "anomalia epilettiforme" non sempre significa
epilessia e 1 risultati EEG devono essere interpretati nel contesto clinico con cautela. Pertanto,
I'EEG dovrebbe sempre essere correlato alla storia clinica e agli studi di imaging. La sensibilita
dell’EEG ¢ compresa fra il 29% al 55%. Tuttavia, la sensibilita migliora di circa 80-90% se gli
EEG vengono ripetuti nel tempo. Anche la tempistica dell'EEG ¢ molto importante, il 51% degli
EEG ¢ anormale se eseguito entro 24 ore dalla crisi mentre solo il 34% mostra delle anomalie
negli EEG eseguiti successivamente. [36]

* Neuroimmagini. Il ruolo delle neuroimmagini dell’encefalo negli anni ha assunto un valore
sempre piu importante ai fini della diagnosi, prognosi e trattamento delle epilessie. Infatti, ci
permette di: individuare le sedi anatomiche di lesioni che causano I’epilessia, fare una
caratterizzazione per la diagnosi eziologica (lesioni neoplastiche, infettive, ischemiche,
malformazioni corticali, etc), evidenziare anomalie strutturali specifiche (es. dettaglio delle
regioni temporali per la sclerosi temporo-mesiale), distinguere tra varie patologie quelle
epilettogene e identificare le possibili conseguenze strutturali di crisi epilettiche. Inoltre le
neuroimmagini possono essere utili per una conferma diagnostica di attivita epilettiforme in atto o
recente (figura 19). La risonanza magnetica (RM) ¢ utile per la valutazione di pazienti con
epilessia focale farmacoresistente candidabili al trattamento neurochirurgico.[37]
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Figura 19 - Neuroimmagine che evidenzia delle scariche epilettiformi interictali focali nella zona
temporale del cervello

3.7 - Terapia

Una volta confermata la diagnosi il medico deve prescrivere al paziente una terapia personalizzata.

Il trattamento pud aiutare la maggior parte delle persone con epilessia ad avere meno crisi 0 a

smettere completamente di avere crisi epilettiche. [39]

L’epilessia, infatti, non dura necessariamente tutta la vita ed € considerata risolta se una persona non

ha piu avuto crisi negli ultimi 10 anni (in assenza di terapia antiepilettica per almeno gli ultimi 5

anni) o quando una persona ha superato 1’eta di una sindrome epilettica eta-dipendente [32]. Le

possibili terapie sono: [39]

* Dei medicinali chiamati farmaci antiepilettici (DAE)

« Un intervento chirurgico per rimuovere una piccola parte del cervello che causa le convulsioni

* L’inserimento di un piccolo dispositivo elettrico all'interno del corpo che puo aiutare a controllare
le convulsioni (stimolazione del nervo vago o stimolazione cerebrale profonda).
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+ Una dieta speciale (dieta chetogenica) che puo aiutare a controllare le convulsioni

3.7.1 - Farmaci antiepilettici.

I farmaci antiepilettici costituiscono il trattamento pil usato per 1’epilessia, nel 70% dei casi aiutano
a controllare I’epilessia. I DEA, modificando 1 livelli di sostanze chimiche nel cervello, possono
fermare le convulsioni (non curare 1’epilessia). Molte persone potrebbero continuare ad assumere
farmaci antiepilettici per tutta la vita a meno che le convulsioni non iniziano a scomparire, in tal
caso dopo due o tre anni, sotto consiglio del medico, il paziente puo interrompere 1’assunzione.

3.7.2 - Neurochirurgia.

La chirurgia dell’epilessia deve essere presa in considerazione dal medico quando i DEA non
riescono ad eseguire un controllo adeguato sulle convulsioni. Inoltre ¢ possibile farla solo se le crisi
hanno origine in una piccola area ben definita del cervello e se questa area non interferisce con
funzioni vitali come la parola, il linguaggio, la funzione motoria, la vista o 1’'udito. Dopo
I’intervento chirurgico € possibile, in alcuni casi, che il paziente continui la cura con i DEA (ma in
minore quantita). Inoltre ¢ possibile incorrere a dei rischi dovuti alla chirurgia, come problemi con
la memoria, l'umore o la vista. Questi problemi possono migliorare nel tempo o possono essere
permanenti. [39]

3.7.3 - Stimolazione del nervo vago

La stimolazione del nervo vago (VNS) ¢ attuata con uno stimolatore (simile al pacemaker)
impiantato sotto la pelle del torace e collegato mediante dei fili al nervo vago del collo. Lo
stimolatore ¢ alimentato a batteria e invia raffiche di elettricita al nervo. Non ¢ chiaro come questo
inibisca le convulsioni, ma il dispositivo di solito pud ridurre le convulsioni dal 20 al 40%. La
maggior parte delle persone ha ancora bisogno di assumere i DEA, sebbene alcune persone possano
essere in grado di ridurre la dose del farmaco. [39]

3.7.4 - Stimolazione cerebrale profonda

La stimolazione cerebrale profonda (DBS) ¢ simile alla VNS, ma il dispositivo posizionato sotto la
pelle del torace ¢ collegato a fili che corrono direttamente nel cervello. La DBS ¢ attuata
impiantando dei elettrodi in una parte specifica del cervello (talamo). Inviando impulsi elettrici al
cervello pud ridurre le convulsioni. E abbastanza recente come terapia e dunque ancora non si
conosce quanto sia efficace. I rischi associati possono essere sanguinamento
cerebrale, depressione e problemi di memoria. [39]

3.7.5 - Dieta chetogenica.

La dieta chetogenica & una dieta ricca di grassi e povera di carboidrati e proteine. E consigliata
soprattutto per i bambini perché si pensa che modificando i livelli di sostanze chimiche nel cervello,
le convulsioni possano diminuire. Negli adulti non ¢ ampiamente diffusa perché una dieta del
genere (ricca di grassi) puo portare a gravi condizioni di salute, come il diabete e le malattie
cardiovascolari.

3.8 - Prognosi

I1 70-80% delle persone che manifestano crisi epilettiche per la prima volta generalmente
raggiungono la remissione totale mentre il restante 20-30% continuera ad avere crisi epilettiche
ricorrenti. Infatti, nonostante I'elevato tasso di ricaduta dopo una prima crisi epilettica, la remissione
di solito si verifica precocemente e per la maggior parte delle persone 1'epilessia ¢ una condizione di
breve durata. La prognosi puo essere influenzata da alcuni problemi di diagnosi [40]. I pazienti con
epilessia possono essere classificati in 4 diversi gruppi prognostici:
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« Ottima prognosi. Questo gruppo comprende circa il 20-30% del totale dei pazienti affetti da
epilessia. 1 pazienti hanno un’alta probabilita di remissione spontanea (comunemente non
richiedono il trattamento AED ). Fanno parte di questo gruppo epilessie focali benigne, epilessia
mioclonica benigna nell'infanzia ed epilessie provocate da modalita specifiche di attivazione
(convulsioni sintomatiche acute, convulsioni indotte da farmaci , convulsioni febbrili) [40].

* Buona prognosi. Circa il 30-40% dei pazienti rientra in questa categoria con epilessia a facile
controllo farmacologico e possibilita di remissione spontanea. La remissione raggiunta ¢
permanente e il paziente puo iniziare a ridurre 1 AED. Fanno parte di questo gruppo l'epilessia
dell'assenza infantile e alcune epilessie focali [40].

« Prognosi incerta. E il gruppo pill piccolo e comprende circa 10-20% del totale. I DAE in questo
gruppo sono soppressivi piuttosto che curativi. I pazienti possono ottenere la remissione ma
tendono a ricadere se il trattamento con farmaci antiepilettici viene interrotto. Infatti nella
maggior parte dei casi i DAE durano tutta la vita. Fanno parte di questo gruppo l'epilessia
mioclonica giovanile e la maggior parte delle epilessie correlate alla localizzazione (sia
criptogeniche sia sintomatiche). Ad alcuni pazienti ¢ consigliata la neurochirurgia (con
conseguente cambiamento di gruppo prognostico). [40]

+ Cattiva prognosi. Quest’ultimo gruppo comprende circa il 20% del totale. I farmaci antiepilettici
in questo gruppo sono palliativi piuttosto che soppressivi. Le crisi, infatti, tendono a ripresentarsi
nonostante il trattamento intensivo (occasionalmente possono passare al gruppo con prognosi
incerta quando trattate con un nuovo DEA). Fanno parte di questo gruppo le epilessie associate a
difetti neurologici congeniti, disturbi neurologici progressivi e alcune epilessie parziali
sintomatiche o criptogeniche.[40]

3.9 - Mortalita dell’epilessia

L’epilessia comporta un aumento di mortalita di due o tre volte maggiore rispetto al resto della
popolazione. La causa dei decessi puo essere direttamente o indirettamente correlata all’epilessia. |
decessi correlati direttamente all’epilessia sono piu rari. Infatti la cause piu frequenti sono la
polmonite (sopratutto negli anziani), la neoplasie del sistema nervoso centrale (SNC) e non, e le
malattie cerebrovascolari. I suicidi, le morti accidentali e la cardiopatia ischemica non sembrano
contribuire in modo significativo al tasso di mortalita. Per quanto riguarda le cause dirette, quella
piu comune ¢ il fenomeno SUDEP (in inglese Sudden Unexpected Death in Epileps) ovvero la
morte improvvisa inattesa nell’epilessia; la tratteremo nel prossimo paragrafo. I pazienti che
continuano a soffrire di convulsioni sembrano avere un rischio di mortalita quasi 40 volte superiore
rispetto a quelli in remissione.[41]

3.9.1 - Morte improvvisa ed inaspettata in epilessia

Per SUDERP si intende un “decesso improvviso ed inaspettato in soggetti con epilessia, non causato
da cause accidentali o da stato di male, e con un esame autoptico e tossicologico che non ne
spiegano la causa” (Nashef, 1997) [42]. Le stime della frequenza della SUDEP sono fortemente
influenzate dalla popolazione in studio, una stima generale ¢ probabilmente <1% [41]. I fattori di
rischio che si pensa che possano causare il fenomeno SUDEP includono I’eta (intorno ai 20-40
anni), sesso maschile, convulsioni refrattarie, epilessia sintomatica remota, non conformita al
trattamento, recente trauma cranico e abuso di alcol. SUDEP avviene spesso senza testimoni ma, tra
coloro che sono stati testimoni affermano che la maggioranza ¢ associata a convulsioni, suggerendo
cosi che le crisi sono direttamente e causalmente correlate a SUDEP [41]. SUDEP rimane un
motivo di preoccupazione particolare sia fra 1 giovani sia fra i medici su quando dovrebbero
discuterne con i pazienti a rischio.[41]
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Capitolo 4 - LE PRINCIPALI INDAGINI ELETTROENCEFALOGRAFICHE
EFFETTUATE IN CASO DI EPILESSIA.

Come abbiamo visto nel paragrafo 3.6.1 I’EEG rappresenta lo strumento fondamentale per la
diagnosi, la prognosi e il management dell’epilessia. I vari tipi di registrazione EEG utilizzati per la
diagnosi ed il management dei pazienti con epilessia sospetta o gia accertata sono rappresentati da:

- EEG di routine (S/EEG, Standard EEG)

- EEG Dinamico o EEG delle 24 ore (A/EEG, Ambulatory EEG)

- EEG con Videoregistrazione (Video-EEG)

- Monitoraggio Video-EEG a lungo termine (LTVEEG Monitoring)

4.1- Elettroencefalogramma di routine
L’EEG di routine ¢ I’indagine neurofisiologica piu diffusa. L’esecuzione consiste in una

registrazione della durata di 20/30 minuti in uno stato di veglia quieta. Successivamente si
impiegano delle tecniche di attivazione che sono I’iperventilazione (HP), in cui il paziente deve
respirare con una frequenza maggiore per 3 minuti (cio permette di indurre le crisi di assenza), ¢ la
stimolazione luminosa intermittente (SLI). Durante la SLI viene posto davanti al paziente, ad una
distanza di 30 cm, una lampada che genera sequenze di flash (sequenza di durata pari a 5 sec a
occhi aperti seguiti da 5 sec con occhi chiusi) e serve per riconoscere la presenza di epilessie
fotosensibili. L’EEG di routine ha una sensibilita compresa fra il 26 e il 59% nell’identificare
anomalie epilettiformi intercritiche e/o critiche in soggetti con sospette crisi epilettiche. Nel’EEG
di routine sono possibili anche dei falsi positivi, infatti lo 0,5-4% dei pazienti non affetti da epilessia
puo riscontrare un’attivita EEG di tipo epilettiforme (soprattutto se il paziente ¢ affetto da altre
patologie neurologiche). Nel caso in cui I’EEG di routine non riesca a verificare una diagnosi certa
o probabile di epilessia si attuano dei metodi di registrazione che aumentano di gran lunga il
contenuto informativo. Queste metodologie sono la registrazione EEG durante il sonno spontaneo e
la registrazione dopo la privazione del sonno, aumentando cosi la sensibilita al 90%. Un aumento
della precisione informativa ¢ riscontrabile se I’EEG ¢ attuato subito dopo la prima crisi (entro
24-48 ore), infatti se ’EEG e attuato dopo molto tempo ¢ possibile che un paziente con epilessia
diagnosticata clinicamente mostri un EEG del tutto normale. I1 valore prognostico dell’EEG
standard nel prevedere il rischio di sviluppo d’epilessia dopo una prima crisi ¢ alto (sopratutto per le
crisi generalizzate poiché sono soggette a un maggior rischio di ricaduta rispetto a quelle focali)
[43]. Infine, esistono situazioni in cui I’EEG ¢ disinformativo. Nelle sincopi infatti possono essere
presenti delle alterazioni aspecifiche basali nel’EEG che possono portare ad un errore diagnostico
[44]. Una volta definita la diagnosi mediante EEG, la ripetizione dell’esame elettroencefalografico
non deve essere abusato, va ripetuto a cadenze definibili soltanto in base al tipo di epilessia, alla sua
risposta al trattamento ed a molte altre variabili anch’esse cliniche. La ripetizione periodica o
routinaria dell’EEG dovrebbe essere evitata. [43]

4.2- Elettroencefalogramma Dinamico o EEG delle 24 ore

L’EEG dinamico ¢ una tecnica di monitoraggio che consente la registrazione di un EEG continuo
per 24-72 ore a casa (anche durante la notte) in cui paziente ¢ libero di svolgere le normali attivita
quotidiane (figura 20) [44]. L’EEG dinamico ¢ utilizzato per la diagnosi di varie patologie ma il suo
principale utilizzo ¢ per lo studio dell’epilessia. L’EEG dinamico, infatti, ¢ utile nella diagnosi
differenziale tra manifestazioni epilettiche e fenomeni parossistici non epilettici. Inoltre ¢ usato per
la quantificazione delle anomalie epilettiche, critiche e intercritiche, focali o generalizzate; si
possono definire cosi dei parametri come il numero totale di scariche/h, il tempo totale di scarica/h,
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la durata media, minima e massima delle scariche [45]. Infatti, anche quando la diagnosi e il tipo di
crisi sono certe, ¢ importante conoscere la frequenza della crisi. [46]

Figura 20 - Utilizzo dell’EEG ambulatorio nelle normali attivita ricreative

4.3- Elettroencefalogramma con Videoregistrazione

L’esame EEG associato ad una videoregistrazione del comportamento del paziente risulta molto
utile per registrare un evento critico e consentire di identificarne la natura con certezza tramite
video, riuscendo dunque a fare una corretta diagnosi differenziale tra crisi epilettiche e non.

4.4- Monitoraggio video-elettroencefalografia a lungo termine
Il Monitoraggio video-elettroencefalografia a lungo termine (LTVEEG) costituisce I’esame gold

standard, ovvero 1’esame piu accurato che permette di confermare dubbi diagnostici. Questo esame
consente una simultanea registrazione video ed EEG (VEEG) del paziente 24h/24, per una durata
variabile da 1 a 15 giorni circa, permettendo di acquisire cosi il dato clinico insieme a quello
neurofisiologico. LTVEEG permette la diagnostica differenziale tra crisi epilettiche e non, la
classificazione e caratterizzazione dei tipi di crisi e sindromi epilettiche , una valutazione pre-
chirurgica nei pazienti con epilessia farmaco-resistente. Spesso ¢ necessario applicare dei metodi
che inducono le convulsioni se le crisi del paziente non sono frequenti. Cio si fa attraverso la
riduzione graduale o la sospensione dei farmaci antiepilettici (DAE), l'iperventilazione, la
privazione del sonno e la stimolazione fotica [47].
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CAPITOLO S - ANALISI DI UN CASO REALE

5.1 - Descrizione della storia clinica di un caso reale.

Il segnale che ho utilizzato per I’analisi elettroencefalografica, preso da Physionet, appartiene a un
database raccolto dall'Unita di Neurologia e Neurofisiologia dell'Universita di Siena durante un
progetto di ricerca regionale, denominato PANACEE. Questo progetto di ricerca ¢ finalizzato allo
sviluppo di dispositivi di monitoraggio/controllo (non invasivi) a basso costo per la previsione delle
crisi epilettiche di un paziente. Nel database sono presenti 14 cartelle contenenti registrazioni EEG
di pazienti monitorati con un Video-EEG a cui ¢ stato chiesto di rimanere a letto il piu possibile,
addormentati o svegli. Gli elettrodi sono stati posizionati secondo il sistema internazionale 10-20, la
frequenza di campionamento usata ¢ 512 Hz. Il paziente che ho analizzato ¢ un uomo di 55 anni con
una epilessia ad esordio focale con consapevolezza alterata. Il periodo totale di registrazione ¢ 198
ore e in questo lasso di tempo il paziente ha avuto 5 crisi. Io ho analizzato la prima registrazione che
inizia alle 19.39.33 e finisce alle 20.22.58. In questo lasso di tempo il paziente ha avuto una crisi
dalle 19.58.36 alle 19.59.46. I canali EEG usati sono 29 e il formato ¢ EDF (European Data
Format). [48] [49] [50]

5.2 - Toolbox EEGLab

Per analizzare un segnale elettroencefalografico ho usato EEGLAB. EEGLAB ¢ un toolbox
interattivo MATLAB open-source progettato dallo Swartz Center for Computational Neuroscience
(SCCN) dell’Universita della California San Diego (UCSD). Questo toolbox ¢ ampiamente
utilizzato per I’elaborazione di dati e segnali elettrofisiologici provenienti ad esempio da EEG o
magnetoencefalografia (MEG). Esso permette di fare varie analisi come la visualizzazione dei dati
(scorrimento, mappa del cuoio capelluto), la preelaborazione (rimozione artefatti, filtraggio,
selezione dell'epoca e calcolo della media), 1’esecuzione dell’algoritmo ICA (analisi delle
componenti indipendenti), la scomposizioni tempo / frequenza ecc. EEGLAB dispone di
un’interfaccia grafica (GUI, Graphical User Interface) che rende pratico e intuitivo il suo
funzionamento senza essere vincolati alla conoscenza della precisa sintassi dei comandi MATLAB.
Infatti dall’interfaccia iniziale sono accessibili tutte le sue funzionalita in modo tale che il clinico,
servendosi di vari menu e finestre, riesca, in modo interattivo, ad arrivare al risultato finale. Inoltre
EEGLab permette anche di implementare plug-in personalizzati integrandoli nei menu della sua
interfaccia grafica (come ad esempio EPINETLAB per lo studio dell’epilessia). In questo paragrafo
presentero un tutorial sui principali comandi di EEGLab affinché possiamo riuscire ad estrapolare i
vari ritmi cerebrali Theta, Alpha, Beta e Gamma ed individuare le relative componenti
maggiormente significative e 1’elettrodo dominante. [51] [52]

5.2.1 - Avvio EEGLab

Una volta avviato MATLAB, per iniziare ad usare EEGLab, occorre selezionare dal prompt dei
comandi la cartella in cui tale toolbox ¢ contenuto. Successivamente, digitando nella Command
Window il comando “eeglab” e premendo invio si aprira I’interfaccia grafica d’interesse (figura 21).
La finestra principale blu di EEGLAB ha un menu composto da sette intestazioni ordinate da
sinistra a destra nel tipico ordine di utilizzo: File, Edit, Tools, Plot, Study, Dataset, Help (figura 22).
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Figura 21 - Avvio EEGLab mediante il comando “eeglab” nella Command Window di MATLAB
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Figura 22 - Finestra d’avvio EEGLab
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5.2.2 - Importazione di un segnale EEG

Per importare un set di dati esistenti (nel nostro caso un file in formato EDF preso da physionet)
occorre, partendo dalla finestra d’avvio blu di EEGLab, selezionare le seguenti voci in cascata:

File -> Import Data -> Using EEGLAB functions and plugins -> From EDF/EDF + / GDF files
(BIOSIG toolbox). (Figura 23).

o0 e EEGLAB v2019.1
[3Il:W Edit Tools Plot Study Datasets Help =~
Import data b Using EEGLAB functions and plugins » (for more use menu File > Manage EEGLAB extensions)
Import epoch info > i i .
Import event info < Using the FILE-10 interface From ASClI/float file or Matlab array
Export > Using the BIOSIG interface

From Biosemi BDF file (BIOSIG toolbox)

From EDF/EDF+/GDF files (BIOSIG toolbox)

Import Philips .mff file

Troubleshooting data formats...
Load existing dataset T
Save current dataset(s)
Save current dataset as | i S,
Clear dataset(s) B oions data From Neuroscan .CNT file
B~ From Neuroscan .EEG file

pcinnous data”

fata folder)

Create study >
3 From Brain Vis. Rec. .vhdr file
ake timel

Load existing study B ocine zcar From Brain Vis. Anal. Matlab file

Save current study
Save current study as
Clear study / Clear a

cha”

In scalp arrav”

Preferences

History scripts >
Manage EEGLAB extensions

Quit

Figura 23 - procedura d’importazione di un file EDF contenente un segnale EEG

EEGLab, una volta attuati questi procedimenti ¢ dopo aver inserito il file d’interesse, premendo
“apri”, rispondera a video con questa schermata (figura 24).

O [ ] Load data using BIOSIG -- pop_biosig()

Channel list (defaut all):
Data range (in seconds) to read (default all [0 2625])
Extract event
Import anotations (EDF+ only)
Force importing continuous data
Reference chani(s) indices - required for BIOSEMI

Import as memory mapped file (use if out of memory error)

Help Cancel Ok

Figura 24 - Procedura di settaggio del file EDF importato
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Nel nostro caso il numero totale di canali non comprende solo il numero dei canali EEG ma altri
canali come ad esempio 1’elettrocardiogramma (ECG). Quindi, in questa finestra, per analizzare
solo 1 29 canali dell’EEG, occorre inserire nel blocco Channel list (defaut all): “1:29”. Cosi facendo
EEGLab predera in considerazione solo i primi 29 canali che corrispondono ai 29 elettrodi applicati
sul cuoio capelluto per attuare la misurazione. Premuto il tasto “Ok” EEGLab rispondera
visualizzando a video la seguente finestra (figura 25).

@® O @ Datasetinfo -- pop_newsst()

What do you want to do with the new dataset?
Mame it EEG a29 canali Edit de...

Help Cancel Ok

Figura 25 - Finestra info dataset.

In questa finestra, cliccando Edit description, possiamo inserire dei commenti al Dataset oppure
cliccando direttamente “Ok” andremo avanti nel caricamento dei dati. Facendo cosi EEGLab ci
aprira la finestra informativa relativa al nostro segnale: EEG a 29 canali (figura 26).

®e0® EEGLAB v2019.1
File Edit Tools Plot Study Datasets Help

—#1: EEG a 29 canali

Filename: none

Channels per frame 29
Frames per epoch 1344000
Epochs 1
Ewvents none
Sampling rate (Hz) 312
Epoch start (sec) 0.000
Epoch end ([5ec) 2624 .998
Reference unknown
Channel locations No (labels onlv)
ICA weights Ho
Dataset size ([(Mb) 166.7

Figura 26 - Finestra informativa relativa al nostro segnale
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5.2.3 - Importazione di un channel location file

I channel location sono dei file essenziali quando lavoriamo con un segnale analizzato mediante
EEGLab. Infatti attraverso i channel location, che contengono le coordinate spaziali di tutti gli
elettrodi utilizzati, possiamo visualizzare le mappe del cuoio capelluto EEG in formato 2D o 3D e
inoltre possiamo attuare la decomposizione del segnale nelle corrispondenti componenti
indipendenti tramite 1’algoritmo ICA. Per caricare o modificare le informazioni sulla posizione dei
canali ¢ necessario selezionare dal menu di EEGLAB le seguenti voci in cascata: Edit -> Channel
locations (figura 27).

0@ EEGLAB v2019.1
File I8 Tools Plot Study Datasets Help ~

___{ Datasetinfo

Event values
| About this dataset
| Channel locations

! Select data
Select data using events
Select epochs or events

m

: Copy current dataset
Append datasets
Delete dataset(s) from memory

L

Channel locations No [(labels only)
ICA welghts Ho
Dataset size ([(Mb] 166.7

Figura 27 - Procedura per importare un file channel location

MATLAB rispondera a video con la finestra della figura 28 e successivamente, dopo aver premuto
“Ok”, con la finestra della figura 29. In quest’ultima schermata possiamo inserire manualmente le
coordinate polari o cartesiane relative ai vari elettrodi oppure importare un file di localizzazione
presente gia in EEGLAB con tutte le informazioni memorizzate. Nel nostro caso, pero, il dataset in
cui abbiamo scaricato il nostro segnale su physionet non faceva alcun riferimento alle coordinate
relative alle posizioni dei 29 elettrodi e inoltre non c’era nessun set di posizioni fra quelli dati da
EEGLAB che fosse applicabile al nostro segnale in questione. Dunque, per trovare
automaticamente le coordinate dei nostri canali, conoscendo solo il nome delle loro posizioni (Fpl,
F3, etc), dobbiamo digitare un opportuno codice Matlab nella Command Window. Attraverso questo
codice verranno cercate le posizioni dei canali d’interesse in un database di 385 etichette di canali
definiti, il file "Standard-10-5-Cap385.sfp" nella sottocartella "function/resources" di EEGLAB.
Facendo cosi MATLAB ci rimostrera a video la figura 28 e successivamente premendo “Ok™ si
aprira la figura 30.
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use BESA file for 4-shell dipfit spherical model .
/Users/gianiuca/Downloads/eeglab2019_1/plugins/dipfit/standard BE | .. |

_ Hep | Cancel || Ok |

Figura 28 - Procedura di inserimento del channel locations

Xyz -= polar & sph.
Sph. -> polar & xyz
Polar ->sph. & xyz

Set head radius
Set channel types
Set reference

Cmsetonn | (<< | (< |1 [ > | [ > | | Awengonan |

L rz ) ossaongx [J | Pet3Dina

| ]

| Hep | | Cancel | | Ok

Figura 29 - Finestra di modifica del channel location
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Xyz -> polar & sph.
Sph. -> polar & xyz
Polar -> sph. & xyz

Set head radius
Set channel types
Set reference

Cweetow |« || < 1> s || peaon |

| |

| Hep |  Camcel | Ok |

Figura 30 - Finestra di modifica del channel location con tutti i parametri dei 29 elettrodi inseriti.

Una volta che sono state inserite automaticamente tutti le varie posizioni, per salvarle bisogna
premere “Save (as. ced)” in basso a destra nella figura 30. Nel nostro caso abbiamo denominato il
file contenente tutte le posizioni d’interesse con il nome “canali2.ced” (figura 31).

Salva col nome: I canali2.ced

Tag: |

Situato in: | [l MATLAB

Figura 31 - Procedura di salvataggio del channel locations
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Ora, dopo aver salvato e premuto “Ok” nella finestra precedente (quella della figura 30) bisogna
ripetere la procedura della figura 27 ( Edit -> Channel locations). Successivamente si aprira la
schermata priva di posizioni della figura 29; cliccando il pulsante “Read location” in basso a destra
e selezionando il nostro nuovo file “canali2.ced” EEGLab rispondera con la finestra seguente
(figura 32):

File format:

Polhemus native .elp file
BESA spherical .elp file
Matlab xyz file

BESA or EGI 3-D cartesian sfp file
EEGLAB polar loc file
Matlab .sph spherical file
Meuroscan polar .asc file
Meuroscan 3-D .dat file

ASA elc 3-Dfile

EEGLAB complete 3-D file
BIDS .tsv file

Brainstorm Matlab file format

Help Cancel Ok

Figura 32 - Finestra di lettura del file location.

Cliccando su “Ok” otterremo come risposta la finestra della figura 30 con tutti i parametri inseriti e
salvati. Premendo anche qui “Ok” EEGLab riuscira a leggere e salvare la posizione di tutti i canali
permettendoci poi anche di visualizzarle. Per visualizzare la mappa 2D e/o 3D della posizione dei
canali per nome o per numero di elettrodo € necessario prima, riaprire la finestra della figura 30
mediante Edit -> Channel locations (se lo avevamo precedentemente chiuso), poi, premere Plot 2-
D sopra il pulsante Read location oppure Plot 3-D nell’altro lato. Altrimenti, in qualsiasi momento
durante una sessione EEGLAB ¢ possibile visualizzare la finestra che ci mostra la mappa 2-D delle
posizioni dei canali selezionando: Plot — Channel locations — By name (o By number).

5.2.4 - Visualizzazione del segnale EEG
EEGLab permette anche di visualizzare I'andamento del segnale EEG registrato da ogni singolo

canale. Per riuscire a visualizzarlo occorre selezionare in cascata i seguenti comandi:
Plot— Channel data (scroll) (figura 33)
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0 ® EEGLAB v2019.1
File Edit TnnlsStudy Datasets Help =~

____#1: EDF file Channel locations [

Channel data (scroll)
Filename: nons Channel spectra and maps
Channels per fra®  Channel properties
R Y 53 GEnEh Channel ERP image
Lut Channel ERPs >

SEenEs ERP map series [ 2
Sampling rate (Hz

Epoch starc (sec)  Component activations (scroll)

Epoch end (sec) Component spectra and maps
Reference Component maps >
channel locations) Component properties

ICA weights Component ERP image

Dataset size (BN Component ERPs >

Sum/Compare comp. ERPs

Time-frequency transforms >

Figura 33 - Procedura per visualizzare il segnale EEG

EEGLab, successivamente, rispondera a video visualizzando una nuova finestra (figura 34).

[ ] & Scroll channel activities -- eegplot()
Figure Display Settings Help

-

Chan. Time  Value =
o BB fpy 248 525 7 =

Figura 34 - visualizzazione di un segnale EEG a 29 canali



In questa finestra si vedra rappresentato il segnale EEG per ogni elettrodo. Nell’asse delle ascisse

abbiamo 1l tempo in s mentre nell’asse dell’ordinate ’ampiezza in pV. A destra della finestra del

grafico troviamo il valore della scala verticale (unita, cio¢ microvolt). Nel nostro caso il valore ¢ 57

pV (lo stesso valore ¢ mostrato anche nella casella di modifica in basso a destra). Da questa finestra

¢ possibile attuare varie modificazioni; possiamo ad esempio cambiare la scala di tensione, la scala
temporale, il numero di canali da visualizzare e lo zoom, inoltre possiamo immettere le linee della
griglia nel segnale.

* Per modificare la scala di tensione non dobbiamo far altro che premere ripetutamente sul il
pulsante “-” o “+” oppure modificando direttamente da tastiera il valore e poi premere "Invio" per
aggiornare la finestra di scorrimento.

* Per modificare la scala temporale bisogna selezionare in cascata i comandi: Settings -> Time
range to display. EEGLab rispondera aprendo a video una finestra in cui € possibile impostare la
durata desiderata in secondi del nostro segnale ovvero in quanti secondi vogliamo visualizzare il
segnale.

* Per modificare il numero di canali da visualizzare bisogna selezionare in cascata i seguenti
comandi: Settings -> Number of channels to display. Successivamente si aprira una finestra in cui
immettiamo il numero di canali che desideriamo visualizzare (ad esempio 3).

* Per zoommare una particolare area di una finestra dati occorre selezionare: Settings ->Zoom off/
on -> Zoom on (o Zoom of). Ora, usando il mouse, possiamo trascinare il rettangolo (che si viene
a creare) attorno ad un'area dei dati interessata per ingrandirla o rimpicciolirla.

* Per visualizzare le linee della griglia orizzontali (x) e verticali (y) sui dati bisogna selezionare in
cascata Display -> Grid -> x grid on (e/o x grid on). Per disattivare uno dei due gruppi di linee
della griglia bisogna ripetere lo stesso procedimento.

5.2.5 - Visualizzazione delle componenti indipendenti e delle varie mappe topografiche

I segnali EEG che vengono acquisiti contengono artefatti significativi [53]. Gli artefatti contenuti
nelle registrazioni EEG sono di grande ostacolo sia per l'interpretazione visiva da parte di esperti sia
per l'elaborazione e l'analisi algoritmica. Infatti, poiché 1 segnali EEG sono nell'intervallo del
microvolt, ¢ probabile che possano essere mascherati da sorgenti artefattive. I tipici artefatti
dell'EEG sono dovuti dalle attivita fisiologiche non neurali del soggetto (come ad esempio il battito
cardiaco, il battito delle palpebre, i movimenti degli occhi, I'attivita muscolare in prossimita della
testa che puo essere causata dal viso, dalla mascella, dalla lingua o dal collo ecc) o da fonti tecniche
esterne [54]. L'analisi delle componenti indipendenti (ICA) ¢ un algoritmo statistico che permette di
rimuovere artefatti che sono linearmente e indipendentemente mescolati con segnali di interesse
[53]. Per comprendere al meglio il problema della separazione delle sorgenti consideriamo
I’esempio del Cocktail party. Supponiamo di trovarci in una stanza con 6 persone che parlano
contemporaneamente. Nella stanza sono presenti 6 registratori, posizionati ciascuno accanto ad una
persona, che registrano le voci e i suoni. Attraverso I’ICA possiamo riuscire ad isolare le parole
dette da una singola persona separandole da tutte le altri sorgenti sonore che saranno considerate
come rumore [53]. Il nostro toolbox EEGLab ci permette di usare diversi algoritmi ICA, nel nostro
caso useremo [I’algoritmo INFOMAX lanciato dalla funzione runica. Per eseguire la
decomposizione ICA dovremo selezionare in cascate le seguenti voci: Tools -> Decompose data by
ICA (figura 35)
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ec e EEGLAB v2019.1
File Edit GRS Plot Study Datasets Help 2|
#1:EE| (Expand tool choices via "File > Preferences")

Change sampling rate
Filename  Filter the data >
Channels  Re-reference the data

Frames B |nterpolate electrodes
Epochs

Events Inspect/reject data by eye
sampiing  Reject data using Clean Rawdata and ASR

Epoch 8

E:m i Decompose data by ICA

Inspect/label components by map

Classify components using ICLabel >

Remove components from data

Refereng
Channel
ICA welg

Dataget

Extract epochs
Remove epoch baseline

Locate dipoles using DIPFIT >

Figura 35 - Procedura di visualizzazione delle componenti indipendenti

EEGLab rispondera visualizzando a video la seguente finestra (figura 36):

[ ] [ ] Run ICA decomposition -- pop_runica()
runica_________________]
ICA algorithm to use (click to select) _bi‘rJi(:a
Commandline options (See help messages) ‘extended’, 1

Reorder components by variance (if that's not already the case)

Channel type(s) or channel indices - types .. channels

Help Cancel Ok

Figura 36 - finestra di importazione dei parametri I[CA

Per dare avvio all’analisi, in caso volessimo attuarla in tutti i canali, occorre premere “Ok”. In caso
volessimo attuarla solo in determinati canali dovremo cliccare sul tasto channels e selezionare i
canali sui quali eseguire 1’algoritmo. Dopo aver premuto “Ok”, nella Command Window di
MATLAB, vedremo una serie di operazioni iterative (nel nostro caso 370 step) che ci restituiranno
le componenti indipendenti del nostro segnale EEG. Otterremo cosi tante componenti quanti sono i
canali (nel nostro caso 29) e ciascuna di esse avra durata pari a quella del segnale EEG. Per
visualizzare tali componenti dobbiamo selezionare in cascata: Plot -> Component activations
(scroll) come mostrato figura 37.
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0@ EEGLAB v2019.1
File Edit TooIsStudy Datasets Help =~

#1:EEG a29( Channel locations >
| Channel data (scroll)
filename: none | Channel spectra and maps

channels per fza8  Channel properties
Erames peciepecll  Channel ERP image
Epochs Channel ERPs >

R | ERP map series >
Sampling rate (Hz|

SRS ERS]  Component activations (scroll)

Epoch end (s=c) | Component spectra and maps
Reference | Component maps >
cnannel lscations| Component properties

ICA weights Component ERP image

Dataset size (B Component ERPs >

Sum/Compare comp. ERPs

Time-frequency transforms >

Figura 37 - Procedura di visualizzazione dei canali EEG

EEGLab rispondera mostrando la seguente finestra (figura 38).

[ ] [ ] Scroll component activities -- eegplot()
Figure Display Settings Help B
Scale
6745
-
Chan. Time Value =
CANCEL 0 5 52855 -25921 67492 REJECT

Figura 38 - Finestra di visualizzazione delle componenti indipendenti

I riferimenti cartesiani e tutte le altre varie funzionalita sono medesime a quelle descritte nel
paragrafo 5.2.5. EEGIab, inoltre, mostra una funzionalitd molto utile, ovvero consente di
visualizzare a video la zona dello scalpo in cui ¢ localizzata la maggior attivita delle varie
componenti e se tale attivita ¢ dovuta da sorgenti artefattive o dall’attivita cerebrale. Per fare cio
dobbiamo selezionare dal menu: Tool — Classify componente using [CLabel — Label components.
(Figura 39)
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edce® EEGLAB v2019.1
File Ediffifetd] Ploi Stud Datase Help EPINETLAB (b

#1! (Expand tool choices via "File > Preferences")

Change sampling rate
rile  Filter the data >
chan  pe-reference the data

Fra%  Interpolate electrodes
Epod
even  INnspect/reject data by eye

sa=y  Reject data using Clean Rawdata and ASR

z:: Decompose data by ICA

were Inspect/label components by map

B Classify components using ICLabel > Label components

.- Remove components from data Flag components as artifacts

View extended component properties
Extract epochs

Remove epoch baseline

Locate dipoles using DIPFIT >

Figura 39 - Procedura di visualizzazione delle Component Maps in 2D

EEGLab rispondera a video con la seguente finestra (figura 40) che consente di scegliere quali
componenti visualizzare sulla mappa 2-D.

@ @ View many chan or comp. properties -- pop_viewpro...

Component indices to plot: 1:29
Spectral options (see spectopo( help): ‘freqrange’, [2 80]
Erpimage options (see erpimage() help):

Draw events over scrolling component activity

| ICLabel 7]

Cancel Ok

Figura 40 - Finestra di settaggio per la visualizzazione delle Component Maps in 2D

Dopo aver selezionato 1 dati di interesse € dopo aver premuto“Ok” EEGLab mostrera la nuova
finestra con le rispettive 29 mappe relative alle componenti. Ora, possiamo eliminare manualmente
le componenti che non sono dovute dall’attivita cerebrale selezionando in cascata le seguenti
istruzioni (figura 41): Tool -> Remove componente from data
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0@ EEGLAB v2019.1
File Eifff3] Plo! Stud Datase Help EPINETLAB (b

#9: (Expand tool choices via "File > Preferences")

Change sampling rate
gils  Fjlter the data >
chan  Ra-reference the data

£r38  |nterpolate electrodes
Epoc

ever  INspect/reject data by eye
sams  Reject data using Clean Rawdata and ASR

zz: Decompose data by ICA

wera Inspect/label components by map

—nan  Classify components using ICLabel >
B Remove components fromdata |
“%%%  Extract epochs

Remove epoch baseline

Locate dipoles using DIPFIT >

Figura 41 - Procedura di eliminazione manuale delle componenti non dovute dall’attivita cerebrale.

Successivamente EEGLab rispondera a video mostrando la seguente finestra (figura 42) in cui ¢
possibile inserire le componenti che vogliamo eliminare.

@ @ Remove components from data -- pop_subcomp()

MNote: for group level analysis, remove components in STUDY
List of component(s) to remove from data

Or list of component(s) to retain

Help Cancel Ok

Figura 42 - Inserimento delle componenti che vogliamo elidere

Premuto “Ok” EEGlab rispondera con la seguente finestra (figura 43)
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Piot ERps Piot singlerias  coept

Figura 43 - Procedura di conferma dell’eliminazione delle componenti selezionate

Una volta premuto “Accept” EEGLab mostrera a video la finestra seguente (figura 44) in cui
possiamo inserire il nome del nuovo dataset (nel nostro caso EEG a 29 canali pruned with ICA) e il
percorso per un suo eventuale salvataggio.

| e

Figura 44 - Finestra di settaggio del nuovo dataset creato con I’eliminazione delle componenti
artefattive

Cliccando “Ok”, EEGLab mostrera a video la finestra informativa relativa al nuovo dataset che nel
nostro caso ¢ EEG a 29 canali pruned with ICA (figura 45).
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o0 ® EEGLAB v2019.1
File Edit Tool Plot Stud Datase Help EPINETLAB (F ~

——#2: EEG a 29 canali pruned with ...

Filename: none

Channels per frame 29
Frames per epoch 1344000
Epochs 1
Events none
Sampling rate (Hz) 512
Epoch 8tart [sec) o.ooo
Epach end (3ec) 2624 .9398
Refarence unknown
Channel locations Tes
ICA weightsa Yes
Dataset size ([Mb) 166.8

Figura 45 - Finestra informativa relativa al dataset #2: EEG a 29 canali pruned with ICA

Facendo cosi avremo un nuovo dataset ripulito dalle componenti maggiormente artefattive. Infatti,
andando a visualizzare I’andamento nel tempo con la procedura 5.2.4 avremo un segnale molto piu
pulito che permette di riconoscere piu chiaramente e piu accuratamente le informazioni utili. Ora
possiamo continuare le nostre analisi su questo nuovo dataset che dipende maggiormente
dall’attivita cerebrale.

5.2.6 - Estrazione dei vari ritmi cerebrali

EEGLab permette anche di andare a studiare individualmente le varie bande del segnale EEG.
Come spiegato nel paragrafo 2.3 ognuno dei cinque ritmi principali (Alpha, Beta, delta, Theta e
Gamma) agisce in un proprio range frequenziale. Da ci0 possiamo intuire che queste onde possono
essere estratte dal segnale principale eseguendo opportune operazioni di filtraggio. Il tool EEGLab
permette di implementare dei filtri numerici FIR (Finite Impulsive Response, in italiano risposta
finita all'impulso) passa banda particolarizzati. Un filtro numerico FIR ¢ un algoritmo che agendo
su un set di campioni riesce a produrne un altro che identifica la funzione d’onda del segnale
filtrato. Per eseguire questa operazione di filtraggio e dunque analizzare una determinata onda sara
necessario selezionare dal menu di EEGLab 1 seguenti comandi:

Tool — Filter the Data — Basic FIR Filter (figura 46)
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| JON | EEGLAB v2019.1
File Edigmislel] Plot Stud Datase Help EPINETLAB (F =

~ gos  (Expand tool choices via "File > Preferences")

| Change sampling rate
. Filter the data

chan  Re-reference the data
ez3%  |nterpolate electrodes

zven  Inspect/reject data by eye
San'rnl Reject data using Clean Rawdata and ASR

Epod

EW:i Decompose data by ICA

RErEE Inspe.ctflahel cumpuner.its by map
cnall Classify components using ICLabel
:c»| Remove components from data
Da'“"; Extract epochs

" Remove epoch baseline

—

Locate dipoles using DIPFIT

Basic FIR filter (new, default)
Windowed sinc FIR filter
Parks-McClellan (equiripple) FIR filter
Moving average FIR filter

Basic FIR filter (legacy)

Figura 46 - Procedura di filtraggio

EEGLab successivamente rispondera a video mostrando la seguente finestra (figura 47). In questa
finestra ¢ possibile settare la frequenza di cut-off inferiore, quella superiore e I’ordine del filtro. In
questo modo, selezionando le relative bande di frequenza su cui agiscono le varie onde, possiamo
andare a studiare tutte le principale onde cerebrali. Infatti, sapendo che I’onda Delta ¢ in un range di
frequenza compreso fra (0.5-3) Hz, per studiarla non dobbiamo fare altro che inserire come
frequenza di taglio inferiore 0.5 e come frequenza di taglio superiore 3. Il campo FIR Filter Order lo
lasceremo vuoto in modo tale che EEGlab calcolera in automatico 1’ordine di filtro necessario alle

specifiche di filtraggio fissate.

[ ] [ ] Filter the data -- pop_eegfiltnew()

Lower edge of the frequency pass band (Hz)
Higher edge of the frequency pass band (Hz)
FIR Filter order (Mandatory even. Default is automatic®)

05

*See help text for a description of the default filter order heuristic.

Manual definition is recommended.

Motch filter the data instead of pass band

Use minimum-phase converted causal filter (non-linear!; beta)

Plot frequency response

Channel type(s)
OR channel labels or indices

Help

0Ok

Figura 47 - Finestra di settaggio per la realizzazione di un filtro FIR
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Dopo aver inserito 1 propri dati d’interesse, calzando “Ok”, EEGLab mostrera a video la seguente
finestra (figura 48) in cui possiamo inserire il nome del nuovo dataset (nel nostro caso Ritmo Delta)
e il percorso per un suo eventuale salvataggio.

Figura 48 - Finestra di settaggio del nuovo dataset creato con I’operazione di filtraggio

Cliccando “Ok”, EEGLab mostrera a video la finestra informativa relativa al nuovo dataset che nel
nostro caso ¢ Ritmo Delta (figura 49).

| File Edit Tool Plof Stud Datase Help EPINETLAB (F ~

Figura 49 - Finestra informativa relativa al dataset #3: Ritmo Delta
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Ora, seguendo le istruzioni dei paragrafi 5.2.5 e 5.2.6 possiamo visualizzare il nostro segnale filtrato
e le nostre componenti indipendenti filtrate.

5.2.7 - Individuazione delle componenti maggiormente significative e dell’elettrodo dominante
EEGLab ci permette, una volta filtrato il segnale, di individuare quali siano le cinque componenti

maggiormente significative e I’elettrodo che registra componenti a maggiore potenza. Nel nostro
esempio abbiamo filtrato il segnale per ottenere le onde Delta, dunque per osservare cid occorre dal
menu principale del segnale filtrato selezionare in cascata:

Plot — Components spectra and maps (Figura 50)

e0ce® EEGLAB v2019.1
File Edit Tool[f[§ Stud Datase Help EPINETLAB (F ~
___ #3:Ritmy Channel locations B

Channel data (scroll)
Filename: 1 Channel spectra and maps
Chamnels 22 Channel properties

frames BEE  Channel ERP image
Epoche Channel ERPs >
Frents ERP map series >

Sampling ra

Epoch starf  Component activations (scroll)

Epoch en

Referenca Component maps >

channel 1ot Component properties

Ica weighte  (Component ERP image

Dacaset ai2  Component ERPs >
Sum/Compare comp. ERPs L

Time-frequency transforms >

Figura 50 - Procedura di esecuzione della funzione Components spectra and maps

EEGLab rispondera a video visualizzando la seguente finestra (figura 51):

@] [ ] Component spectra and maps -- pop_spectopo()
Epoch time range to analyze [min_ms max_ms]: 02624998.0469
Frequency (Hz) to analyze: 1.75
Electrode number to analyze ([J=elec with max power; O=whole scalp): I
Percent data to sample (1 to 100): 20
Components to include in the analysis: 1:29
Number of largest-contributing components to map: 5
Else, map only these component numbers:
[Checked] Compute comp spectra; [Unchecked] (data-comp) spectra:
Flotting frequency range ([min max] Hz): 0.140
Spectral and scalp map options (see topoplot): ‘electrodes’,'of '
Help Cancel Ok

Figura 51 - Finestra di setting della funzione Components spectra and maps
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In questa finestra noi possiamo andare a immettere diversi dati. Nella casella “Frequency (Hz) to
analyze” possiamo impostare la frequenza d’interesse per 1’analisi (nel nostro caso 1,75 Hz poiché
rappresenta il centro della banda interessata dal ritmo Delta). Nella casella inferiore inserendo “[]”
andiamo ad effettuare la ricerca per individuare 1’elettrodo che registra componenti a maggiore
potenza. Nella casella “Components to include in the analysis” ¢ possibile indicare gli elettrodi da
includere nell’analisi (nel nostro caso gli tutti gli elettrodi, da 1 a 29). Nella casella “Number of
largest-contributing components to map” andrei ad indicare il numero delle mappe relative alle
componenti maggiormente significative da rappresentare nel grafico (prefissato a 5). Infine nella
casella “Plotting frequency range ([min max] Hz)” indichiamo I’intervallo di frequenza che verra
visualizzato nel grafico, nel nostro caso il range ¢ compreso tra 0.1 e 40 Hz. Cliccando Ok EEGLab
mostrera a video finestra d’interesse. Possiamo iterare questo studio per ognuna delle onde
cerebrali.

5.3 - Plugin EPINETLab

Molti pazienti con epilessia farmaco resistente richiedono un intervento chirurgico. Per il successo
dell’operazione sono fondamentali dei biomarcatori che identificano correttamente la zona
epilettogena (EZ) e in particolare la zona di esordio delle crisi (SOZ) ovvero |’area responsabile
della generazione della crisi e quindi quell’area candidata all’asportazione. Le oscillazioni ad alta
frequenza (HFO) contenute nel segnale EEG sono state proposte come biomarcatori della SOZ. Le
HFO sono tutte quelle attivita oscillatorie fisiologiche e patologiche comprese fra 80 a 500 Hz che
si distinguono chiaramente della normale attivita elettroencefalografica che si trova al di sotto di 30
Hz. La loro identificazione visiva ¢ un processo oneroso dunque si € pensato allo sviluppo di uno
strumento di rilevamento automatizzato capace di aiutare il medico. In questo paragrafo verra
trattato un software che permette di rilevare le HFO, EPINETLab. EPINETLab ¢ un plugin per
EEGLab che mi permette di circoscrivere la zona di insorgenza delle crisi grazie alla capacita di
rilevare oscillazioni ad alta frequenza (HFO) e quantificarne la presenza in diverse aree cerebrali
[55].

5.3.1 - Avvio EPINETLab

Una volta scaricato EPINELTLab, esso deve essere inserito all’interno della sottocartella “plugins”
che ¢ situata dentro la cartella “eeglab2019” di EEGLAB. Successivamente, alla classica apertura di
EEGLAB dalla Command Windows, vedremo che fra i comandi nel menu principale della finestra
di EEGLAB ci sara in alto a destra anche la voce “EPINETLAB (HFO)” (figura 52).

e0@ EEGLAB v2019.1
File Edit Tool Plo! Stud Datase Help=dl\=®:Cq{; ~
——#2: EEG a 29 canali pruned witl Preprocessing Functions 4
Seizure Inspection
Filename: none
Channels per frame 29 Wavelet-based Time-Frequency Analysis
Frames per epoch 1344000 Kurtosis-based Statistics
Epochs 1 HFOs Detection

Events none

HFOs Visualization (in time)
HFOs rates plot >
SOZ Identification

Sampling rate (Hz) 512

Epoch start (sac) 0.000

zac) 2624.998

HFOs detection on multiple files

IcA weights ves Export HFOs to Micromed

Dataset size (Mo 186.8 Single Pulse Electrical Stimulation (SPES) analysis »
| EPINETLAB Help »

Figura 52 - Barra principale di EEGLAB con il plugin EPINETLAB installato.
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5.3.2 - Analisi tempo-frequenza

Selezionando in cascata 1 seguenti comandi: “EPINETLAB(HFO) -> Wavelet-based Time-
Frequency Analysis”, EEGLab ci mostrera a video la seguente schermata (figura 53) in cui ¢
possibile impostare 1 parametri necessari per eseguire la decomposizione tempo-frequenza basata su
Wavelet.

| JON | MyTimeFrequency
Time-Frequency analysis for HFO detection

Load File name
Signal T Dis res. decimation
L= = ‘Wavelet Analysis
O ecarees j ; Window Langht fsec] 1
MEG raw -

MEG Virtual Senzors

Window Owerlap [sec] o

Start/End lmits [t t2)asc)

all-= whaols intarval
80 250
Frequency Limita [f1 2] Hz]
Mother Wavelst cmor B
omori-1.5
Complex Morlet 1-1.5
s 3 A
g £
g
E
Time Time
Time-fraquency
Aun Display Save
Murtosis staistios and HFOs Detection
Hurtoska statiatics HFO Detection

Closs

Figura 53 - Finestra per analisi tempo-frequenza.

I parametri che possiamo impostare sono ad esempio: i canali su cui eseguire l'analisi, la lunghezza
della finestra di segmentazione (1 s), la sovrapposizione tra finestre consecutive (0 s), I’epoca
(I'intervallo di tempo del segnale) da analizzare, i limiti della banda di frequenza (80-250 Hz) e la
Wavelet madre (Complex Morlet). Tutte le Wavelet disponibili nel Matlab Wavelet Toolbox sono
selezionabili e sono elencate nel pannello di visualizzazione delle Wavelet , suddivise in parti reali e
immaginarie in caso di Wavelet complesse, come riportato in figura 56. Dopo aver premuto “Run”
possiamo visualizzare a video la decomposizione in tempo-frequenza e successivamente possiamo
andare a rilevare le HFO.
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5.3.3 - Rilevamento delle oscillazioni ad alta frequenza
Ora, premendo il pulsante in basso a sinistra “HFO Detection”, EEGLab ci mostrera a video la
seguente finestra (figura 54).

0@ HFODetection2

EEG Fp1 Staba's Method Wavelet-based Method

EEG O ALES Fastures Warsalot Faxtures

EF 75 FIMS Windaw {ms) 21 g Window fms) =1 a

EEG Fz Thrashold (SD) —| 5 Thrashald {SD) —~ | s

Duration {ms) ,A_ ] Duration jms) — 20

Artidact remaval

& hd

Radtified EEG

8
9RITFEQELIT RO
|

Cranne-pased  N.Cn | a3

B
i
L]

Band power-based

Threshald {S0) i‘ 5
-

Salact Al

Select channels after kurtogia

Figura 54 - Procedura di rilevamento delle oscillazioni ad alta frequenza.

Attraverso questa finestra possiamo impostare i parametri per la rilevazione degli HFO mediante
due metodi, lo Staba e il metodo Wavelet. Il rilevamento puo essere eseguito su tutti i canali o su un
sottoinsieme di canali, determinato, ad esempio, dalla soglia della curtosi. Per I'analisi basata su
Wavelet, ¢ disponibile una duplice opzione di rimozione degli artefatti: quella basata sul canale
consente di rifiutare gli HFO candidati che si diffondono in modo sincrono su piu di N canali
(valore di default: 3); quello basato sulla potenza di banda consente di scartare gli HFO candidati
con potenza che si diffonde uniformemente su tutte le frequenze nella banda di interesse, tipiche dei
picchi. I risultati del rilevamento possono essere visualizzati sul segnale originale mediante il
rivelatore Staba e sui coefficienti Wavelet mediante il rivelatore basato su Wavelet. Infatti,
selezionando nel nostro caso “Select All” in basso a sinistra e successivamente “Run” EEGLab
aprira a video la seguente finestra (figura 55).
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Group View 6 List View Export HFO. Export HFO.

Staba Method .| Custom Method

A W ’7 Costf Wind= 3ms; SD Thresh=5; Coeff Durstion= 20ms

o™
e«
e
o
e

o™

Orignal signar

Save Fig Cloge: Window | 1199 of 2624

Figura 55 - Finestra di rilevamento delle oscillazioni ad alta frequenza

Nel pannello di sinistra, viene riportato il segnale EEG rettificato, come richiesto quando si utilizza
il detector Staba. In questo pannello sono riportati i risultati della rilevazione con il detector Staba,
mentre nel pannello di destra sono riportati i risultati della rilevazione basata su Wavelet. Il numero
totale di HFO rilevati viene riportato accanto a ciascun canale. Gli HFO rilevati sono indicati nei
due pannelli con rettangoli tratteggiati rossi, mentre la durata dell'evento con una stringa di testo.
Da questo pannello ¢ possibile scorrere nel periodo di tempo desiderato attraverso la barra inferiore.
Andando a modificare il numero in alto a destra premendo Group View possiamo selezionare il
numero di canali da visualizzare, per spostarci e visualizzare i gruppi successivi dobbiamo muovere
la barra verticale. La barra orizzontale inferiore invece mi permette di spostarmi in diversi istanti di
tempo.Infine selezionando a cascata questi comandi :EPINETLAB (HFO) -> HFOs rates plot ->Plot
HFO rate on sEEG channels (figura 56)

ece® EEGLAB v2019.1
File Edit Tools Plot Study Datasets Help QEZLI":V:{IT0) ~

— #1:EEG a 29 canali Preprocessing Functions >
Seizure Inspection

: Wavelet-based Time-Frequency Analysis
Chamnels per frame 23 Kurtosis-based Statistics
Frames per epoch 1344000 HFOs Detection

R HFOs Visualization (in time)

Frenss fans HFOs rates plot » Plot HFO rate on sEEG channels

Sampling rate (Hz) 512 SOZ Identification Plot HFO rate on sEEG AND grids

Epoch starc (sec) 0.000 . i § Plot HFO rate on MEG channels  »
HFOs detection on multiple files

Epoch end (sec) 2624.998

Reference unknown Export HFOs to Micromed

Channel locations %o (labeis on  Single Pulse Electrical Stimulation (SPES) analysis »

L = EPINETLAB Help >

Dataset size (Mp) 166.7 —r

Figura 56 - Procedura di visualizzazione del tasso delle HFO
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EEGLAB aprira a video una finestra in cui ¢ possibile individuare come istogramma il contributo di
ciascun elettrodo in termini di tasso delle HFO relativo alla nostra epoca.

5.4 - Risultati analisi

In questo paragrafo vengono presentati i risultati, ricavati per mezzo della procedura esposta nei
paragrafi 5.3 e 5.4, relativi alla estrazione dei ritmi cerebrali (Delta, Theta, Alpha, Beta e Gamma),
all’individuazione delle relative componenti maggiormente significative, all’individuazione
dell’elettrodo dominante e infine all’individuazione delle HFO.

5.4.1 - Estrazione dei ritmi cerebrali e individuazione del rispettivo elettrodo dominante
Per prima cosa ho individuato i channel locations del segnale preso in analisi. Nella figura 57 viene
rappresentata la locazione dei 29 elettrodi sullo scalpo in 2-D, nella figura 58 in 3-D.

[ ] o Figure 2
File Edit View Insert Tools Desktop Window Help E
DT de @ 08 (E

Channel locations

29 of 29 electrode locations shown

Figura 57 - Mappa di localizzazione degli elettrodi per nome in 2-D

e ® Figure 3
File Edit View Insert Tools Desktop Window Help ¥
D de @ 0B KO

& og TR
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. Fa0 e
N ]
a \ T &L
\‘“-3\ 0
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Figura 58 - Mappa di localizzazione degli elettrodi per nome in 3-D
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Successivamente, ho rappresentato il nostro segnale EEG nel tempo per ogni elettrodo (figura 59)

o0 ® Scroll channel activities -- eegplot()
Figure Display Settings Help

»

Fpl 4y h'l-.tmuH*Mi lh« Ay i L Virheu b 2Dy
g m ﬂ " *Mﬁ‘w ,M 'QH“W

0 1 2 3 4

Chan. Time Value =
CANCEL 0 Fpl 24379 -525 S REJECT

Figura 59 - visualizzazione di un segnale EEG a 29 canali

Spostandoci attraverso la linea temporale nel momento in cui il paziente ha avuto la crisi epilettica,

I’andamento dell’EEG si presenta in questo modo (figura 60)

0@ Scroll channel activities -- eegplot()
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Figura 60 - visualizzazione di un segnale EEG a 29 canali durante la crisi
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Una volta attuato I’algoritmo ICA per la visualizzazione delle componenti indipendenti EEGLab
mostrera a video questa finestra (figura 61)

[ NoN ] Seroll component activities -- eegplot()
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Figura 61 - Finestra di visualizzazione delle componenti indipendenti

Successivamente nella figura 62 sono rappresentate le rispettive 29 mappe in 2-D relative alle
componenti; esse ci consentono di visualizzare a video la zona del cranio in cui ¢ localizzata la
maggior attivita delle varie componenti e se tale attivita ¢ dovuta da sorgenti artefattive o
dall’attivita cerebrale
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View components properties - pop_viewprops() (dataset: EEG a 29 canali)

5 | | 6 | | 7]

Other : 54.4% Brain : 48.0%
[ 27 | 28 |

Muscle : 46.0% Muscle : 91.6% Other : 71.1% Other : 66.0%
29

Brain : 57.1%

Figura 62 - Finestra delle Component Maps in 2D

Nella figura successiva ¢ rappresentato il segnale EEG ripulito dalle componenti maggiormente
influenzate da artefatti.
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Figura 63 - visualizzazione di un segnale EEG a 29 canali ripulito

54



Ora, continuando a lavorare con il nuovo segnale EEG ripulito dagli artefatti possiamo andare ad

estrarre 1 vari ritmi cerebrali e le relative componenti.

¢ Onde Delta (0.5-3) Hz. Nella figura 64 sono rappresentate le onde Delta, nella 65 le sue
componenti e nella 66 le 5 componenti maggiormente influenti e ’elettrodo dominante.

[ NN ] Scroll channel activities -- eegplot()
Figure Display Settings Help

Chan. Time Value =
ERTE=l 0 Fpl 22377 -43384 2 = SELST

Figura 64 - Onde delta

o0 ® Scroll component activities -- eegplot()
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Figura 65 - Componenti indipendenti delle onde Delta
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[ oW | Figure 2: spectopo()
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Figura 66 - Finestra delle Components spectra and maps relative al ritmo Delta
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« Onde Theta (3-8) Hz
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Figura 68 - Componenti indipendenti delle onde Theta
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Figure 2: spectopo()
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Figura 69 - Finestra delle Components spectra and maps relative al ritmo Theta
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« Onde Alpha (8-12) Hz
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Figura 70 - Onde Alpha
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Figura 71 - Componenti indipendenti delle onde Alpha



[ NON | Figure 3: spectopo()
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Figura 72 - Finestra delle Components spectra and maps relative al ritmo Alpha
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« Onde Beta (12-38) Hz

[ ] ® Seroll channel activities -- eegplot()
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Figura 74 - Componenti indipendenti delle onde Beta
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5.4.2 - Individuazione delle oscillazioni ad alta frequenza
Nella figura 79 viene rappresentata la decomposizione del segnale in tempo-frequenza
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Figura 79 - Analisi del tracciato EEG in tempo-frequenza

Nella figura 80 vengono rappresentate mediante EPINETLab le oscillazioni ad alta frequenza del
nostro tracciato. Il numero totale di HFO rilevati viene riportato accanto a ciascun canale.
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Nella figura 81 e 82 gli HFO rilevati sono indicati nei due pannelli con rettangoli tratteggiati rossi
mentre la durata dell'evento con una stringa di testo.
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Infine nella figura 83 ¢ possibile individuare, mediante un istogramma, il contributo di ciascun
elettrodo in termini di tasso delle HFO relativo alla nostra epoca.
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Figura 83 - Contributo dei canali piu informativi al tasso complessivo di HFO nella nostra epoca.
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5.5 - Discussione

Per attuare le analisi descritte ho utilizzato un database raccolto dall'Unita di Neurologia e
Neurofisiologia dell'Universita di Siena. Ho scelto questo database perché ogni cartella all’interno
tratta di un tipo di epilessia specifica. Il segnale EEG che ho analizzato appartiene ad un uomo di 55
anni affetto da epilessia ad esordio focale e consapevolezza alterata. Per lo studio e le analisi del
tracciato EEG ho usato un toolbox di MATLAB chiamato EEGLab. EEGLab ¢ un software usato
sia da migliaia di ricercatori in tutto il mondo e sia dai clinici poiché grazie alla sua interfaccia
grafica intuitiva permette di attuare delle analisi giornaliere. Per quanto riguarda [’analisi del
segnale EEG mediante EEGLab abbiamo dedotto diverse considerazioni. Innanzitutto nella figura
57 e 58 sono rappresentate le posizioni 2-D e 3-D degli elettrodi nello scalpo. Come si puo notare
dalla figura 57, degli elettrodi sono fuoriusciti dall’area dello scalpo; questo non dovrebbe essere un
problema che porta ad errori per quanto riguarda le analisi successive. E comunque possibile,
andando a modificare i1 parametri degli elettrodi fuori posto, farli rientrare all’interno dello scalpo.
Nella figura 59 invece ¢ rappresentato il nostro segnale EEG per ogni elettrodo. Analizzare il
segnale nel tempo ¢ molto utile poiché ci permette di fare una prima analisi visiva. Infatti, andando
nel periodo di tempo in cui il paziente € colpito dalla crisi epilettica, possiamo notare come 1’attivita
cerebrale sia molto piu intensa (figura 60). Cid conferma, come visto in letteratura, che durante una
crisi epilettica ’attivita neurone cerebrale sia anomala e alterata. Nella figura 62 invece sono
rappresentate le rispettive 29 mappe in 2-D relative alle componenti. Questa figura ci consente di
visualizzare a video le zona del cranio in cui ¢ localizzata la maggior attivita delle varie componenti
e se tale attivita ¢ dovuta da sorgenti artefattive o dall’attivita cerebrale. Infatti, come possiamo ben
notare dalla figura, la prima componente ¢ dovuta dal 93.5% dai movimenti oculari (cosi come la 3
e la 6). Dunque la prima componente rappresenta una distribuzione di potenziale tipica del
“blinking”’causata dal movimento delle palpebre: il suo potenziale raggiunge i massimi valori
(colore rosso) nella regione frontale e va via via scemando (colori piu freddi e tendenti al blu)
dirigendosi verso la regione occipitale. Altre sono dovute invece ai movimenti muscolari, ai rumori
del canale e altri. Le componenti che ci interessano sono quelle composte principalmente
dall’attivita cerebrale e quindi non affette da questi rumori. Eliminando manualmente le componenti
con un tasso di rumore molto grande, nel nostro caso le componenti 1 3 6 9 11 13 23, ¢ possibile
pulire il segnare e visualizzarlo nuovamente (figura 63) per poi continuare le nostre analisi con un
minor grado di incertezza. Infine possiamo andare a estrapolare i nostri 4 ritmi con le relative 22
componenti. Di ogni ritmo, inoltre, possiamo vedere quali siano le componenti che hanno un
maggior peso (nelle onde Delta, figura 66, sono le componenti 2, 14, 18, 13, 17) e I’elettrodo che
registra le componenti a maggior potenza (nella figura 66 1’elettrodo F4). Grazie a queste finestre
possiamo vedere anche 1’andamento in frequenza di tutte le 22 componenti del segnale EEG.
Quest’ultime finestre (66, 69, 72, 75, 78) sono molto importanti poiché da esse posso ricavare molte
informazioni; in base al tipo di onde e alla zona cerebrale dove si esprimono maggiormente infatti
posso dedurre lo stato del paziente. Nel nostro caso, guardando semplicemente la figura 75 io riesco
a sapere che il paziente, poiché abbiamo onde Beta troppo alte nella corteccia posteriore,
probabilmente ¢ in uno stato di ansia e inoltre ha una poca connessione con I’ambiente esterno;
questo ¢ confermato anche dalla presenza di un eccesso di onde Alpha nella corteccia frontale
(figura 72) che provocano appunto ansia (questa stessa onda Alpha nella zona occipitale,
implicherebbe un ottimale stato di rilassamento). Quindi con un’analisi accurata di queste onde
posso ricavarmi varie informazioni utili per le diagnosi. Infatti, la frequenza delle onde cerebrali
puo indicare varie condizioni come: sonno, coscienza, cognizione e alcuni disturbi mentali. Le onde
cerebrali lente sono osservate in alcune condizioni come sonno, coma, morte cerebrale, depressione,
autismo, tumori cerebrali, disturbo ossessivo-compulsivo (DOC), disturbo da deficit di attenzione e
iperattivita (ADHD) ed encefalite, mentre le onde rapide sono generalmente riportate in condizioni
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come l'epilessia, l'ansia, il disturbo da stress post-traumatico (PTSD) e l'abuso di droghe. Per
’analisi specifica in caso di epilessia invece ho usato un plugin di EEGLab ovvero EPINETLab.
EPINETLab ¢ un software molto recente (2018) che permette di individuare la zona d’esordio della
crisi epilettica per aiutare il medico al riconoscimento dell’area cerebrale eventualmente da
asportare. Nella figura 80 viene riportato, sul pannello di destra, il segnale EEG rettificato con il
numero totale di HFO rilevati accanto a ciascun canale, ad esempio notiamo che il numero delle
HFO misurato da O2 ¢ 25. Nella figura 82 possiamo ben notare che durante il periodo della crisi
epilettica gli elettrodi C4, O2 e F8 hanno registrato delle HFO rispettivamente di durata pari a 178
ms, 535 ms e 43 ms. Nella figura 83, invece, ¢ rappresentato un istogramma in cui viene riportato il
contributo di ciascun elettrodo in termini di tasso delle HFO relativo alla nostra epoca. Cio ¢ utile,
ad esempio, per stimare I'evoluzione temporale del contributo di ciascun canale alla generazione di
una crisi in termini di percentuale di HFO. Infatti, attraverso la figura 83, si riesce a determinare
I’area con il piu alto tasso di HFO che ¢ correlata al tessuto epilettogeno cerebrale e dunque alla
zona di esordio della crisi. Nel paziente preso in considerazione 1’area con piu alto tasso di HFO ¢
presumibilmente quella occipitale, poiché i1 canali piu informativi sul tasso complessivo di HFO
nella nostra epoca sono O1 e O2.
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CONCLUSIONI

Lo scopo della mia tesi ¢ stato quello di studiare il segnale EEG di un paziente epilettico per poi
attuare due tipi di analisi. La prima analisi, dopo aver ripulito il segnale da varie sorgenti artefattive,
¢ stata quella di estrapolare 1 quattro ritmi cerebrali principali (Delta, Theta, Alpha, Beta e Gamma)
con il loro rispettivo elettrodo dominante. La seconda analisi, invece, ¢ stata quella di individuare la
zona di esordio della crisi epilettica mediante 1’identificazione delle HFO che sono dei efficaci
biomarcatori in caso di epilessia. Dal caso preso in esame possiamo dire che, come confermato
anche da alcune ricerche in letteratura, 1’attivita cerebrale nel momento della crisi risulta essere
anomala e alterata. Inoltre, ¢ emerso dall’individuazione degli elettrodi dominanti nei vari ritmi
cerebrali che il paziente, nell’arco della registrazione elettroencefalografica, probabilmente sia stato
in una condizione di ansia. Dallo studio sull’individuazione delle HFO possiamo invece concludere
che presumibilmente, poich¢ il maggior contenuto delle HFO ¢ stato registrato dagli elettrodi O1 e
02, la zona d’esordio della crisi, dunque quella candidata per una eventuale asportazione, ¢ quella
occipitale.
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